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INTRODUCTION



WELCOME Whenever you are learning a craft or skill, there often comes a point when you reach a plateau. After a period of learning, suddenly you ﬁnd yourself on autopilot going through the same old routine. Don’t worry – it happens to the best of us. In this issue of Amateur Photographer: Advanced Photography Skills, we have come up with 20 ideas that will help motivate and inspire your photography. These ideas should help you to think about your photography in a different way, perhaps by learning



a new skill or setting yourself a challenge. In fact, this whole magazine is full of ways to help help you become a better photographer, from trying out new image-editing skills on your landscapes to learning how to take better travel and street pictures. There is also a complete guide to how to minimise the amount of noise in your photos. Plus, we have valuable advice on ﬁlters, cable releases, projectors and old lenses. Hopefully, you’ll all be inspired to go out and take some amazing images this spring! Richard Sibley, Editor



THE TEAM EDITOR: Richard Sibley ART EDITOR: Simon Warren PRODUCTION EDITOR: Oliver Cotton CONTRIBUTORS: Debbi Allen, Nigel Atherton, Oliver Atwell, Barney Britton, David Clapp, Tim Coleman, Chris Gatcum, Callum McInerney-Riley, Professor Robert Newman, Angela Nicholson, Vincent Oliver, Robert Sibley, Jon Stapley PUBLISHING DIRECTOR: Alex Robb SENIOR MARKETING MANAGER: Samantha Blakey ONLINE MANAGER: Karen Sheard ADVERTISING: Mark Rankine, Julia Laurence, Simon Gerard, Sophia Freeman



WorldMags.net



Amateur Photographer™is a trademark of IPC Media Ltd © 2014 IPC Media Ltd ISSN No. 0002-6840



Advanced Photography Skills is a Focus Network title, published by IPC Inspire, part of IPC Media Ltd, Blue Fin Building, 110 Southwark Street, London SE1 0SU



ADVANCED PHOTOGRAPHY SKILLS 3



CONTENTS



WorldMags.net



CONTENTS 7 CONTROLLING DIGITAL NOISE Everything you need to know



16 12 ESSENTIAL LANDSCAPE EDITING SKILLS Get the best possible landscape images



54 TRAVEL PHOTOGRAPHY Your essential guide to shooting round the world



60 MAKE YOUR OWN PHOTO BOOK It’s not as hard as you think



25 LIGHTING GELS



Avoid the photographic rut with a new challenge



83 APS-C-FORMAT DSLR KIT LENS UPGRADE Get sharper images and greater versatility



The cheapest accessories can be the most useful



90 PORTABLE PROJECTORS



31 LONG EXPOSURES



Display your images at a moment’s notice



How to do them right



92 CABLE-RELEASE SYSTEMS



37 USE SHALLOW DEPTH OF FIELD



Six of the best



94 CHECK A SECOND-HAND LENS



Get creative with wide-open apertures



43 PAINT WITH LIGHT



What to look for when buying



97 LEARNING TO LOVE THE FLAWS



Capture exciting hand-lit images



48 THE PERFECT RATIO Give your photos the panoramic treatment



Use lens imperfections creatively



50 STREET PHOTOGRAPHY



101 SQUARE FILTERS



Why not try it yourself?



Buyers’ guide



WorldMags.net 4 ADVANCED PHOTOGRAPHY SKILLS



64 20 IDEAS TO INSPIRE YOUR PHOTOGRAPHY



WorldMags.net



7 CONTROLLING DIGITAL NOISE



16 12 ESSENTIAL LANDSCAPE EDITING SKILLS



50 STREET PHOTOGRAPHY



97 LEARNING TO LOVE THE FLAWS



64 20 IDEAS TO INSPIRE YOUR PHOTOGRAPHY



83 APS-C-FORMAT DSLR KIT LENS UPGRADE WorldMags.net ADVANCED PHOTOGRAPHY SKILLS 5



WorldMags.net



WorldMags.net



CONTROLLING DIGITAL NOISE



WorldMags.net



CONTROLLING DIGITAL NOISE It is the bane of many digital photographers’ lives, but what exactly is image noise, how is it caused and what can be done to reduce it? Here, we explain everything you need to know ASK ANY photographer what improvements they would like made to their digital camera and most would place image-noise reduction quite high on the list. Even though sensor technology has improved dramatically over the past few years, image noise is still an inevitable part of digital photography. It doesn’t matter



whether your camera is a compact, a bridge model or a full-frame DSLR, at some point your photographs will suffer from image noise. However, regardless of the type of digital camera you own, there are ways that image noise can be reduced, whether it is through software, changing your exposure settings or simply by understanding



exactly how your camera’s sensor works. Over the following eight pages, we’ll explain to you exactly what causes digital image noise, as well as how to use raw image-editing software to reduce it. We’ll also show you how to correctly expose an image to keep noise to an absolute minium, for the best possible images.
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THE ORIGINS OF NOISE



Fig 1



200%



What is noise? Why does noise occur in digital photographs? What can we do to get rid of it? Read on to ﬁnd out… NOISE is a major problem in lowlight photography. While there is a degree to which noise can be a friend if the aim is an atmospheric look, most photographers want to get rid of it. Here, we will look at the forms of noise, why they occur and the strategies for dealing with them when shooting and during post-processing.



WHAT IS NOISE? Noise is simply a random variation of a signal from an expected value. The term arises from the hiss heard on early radio systems. Where there should have been silence, the radio operators heard a hiss, which they called ‘noise’. The term became commonly used in electronics to describe the random variations from the perfect signal, and thereafter became transferred along with the electronics when photography went digital. In ﬁlm there was ‘grain’, which is actually a completely different phenomenon, although it has some perceptual similarities. It’s worth pointing out here that ‘noise’ is not something separate from the signal, it is a part of it. 8 ADVANCED PHOTOGRAPHY SKILLS



Noise is simply an observed variation of the signal, which is why it can’t simply be ‘sliced off’. There is no way to differentiate between noise and the signal, at least without prior knowledge of what the scene is. In the next three sections, we’ll look at the three main sources of noise.



ELECTRONIC NOISE Electronic noise, often called ‘read noise’, is the result of the electronic circuitry in the camera adding noise to a signal passing through. It is caused by the randomised release of electrons, which increases as the circuitry gets warmer. Many people think this is the major source of noise in a camera, but in fact in modern cameras it is very small. It is also not dependent on the signal, as it remains at the same very low level whatever the brightness of the image. The result of this is that electronic noise is soon swamped by any brightness in the image. Therefore, it mainly inhabits the shadows (see ﬁgure 1). With some cameras, the amount of electronic noise relative to the signal decreases as the ISO control



is turned to a higher setting. This is non-intuitive to many photographers, who feel that electronic noise should increase as the ‘volume’ is turned up. However, doing this just makes the same noise louder along with the signal – it doesn’t add new noise. The signal-to-noise ratio due to electronic noise doesn’t reduce as the ISO increases, and, as said before, with some cameras (particularly Canon DSLRs) it actually improves.



PHOTON NOISE The light that makes up an image is not a continuous phenomenon. It is delivered in individual packets or quanta, called photons. The process of building up an image from photons is akin to sprinkling chocolate powder on a cappuccino coffee. Add just a little chocolate, and you’ll see a clear random pattern of dots. Add more, and the chocolate colour becomes more obvious and the random pattern not so pronounced. Add enough, and the froth will be covered with chocolate and will be a uniform brown, although close inspection will still reveal that the pattern is made of randomly organised dots. The same is true of photons, as the less light (and therefore photons) we use to make an image, the more the randomness is apparent – in electronic terms, the lower the signal-
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Figure 1: Electronic noise is mainly apparent in the shadow areas to-noise ratio is. The statistics of noise tell us that the signal-to-noise ratio is given by the square root of the number of photons counted in the pixels of an image (not necessarily the captured pixels, as this applies also to the output pixels, and this measure is arguably more important, since it is the one that counts when we view an image). This tells us that the signal-tonoise ratio is greater (less noisy) in the bright parts of an image. It should now be apparent that the shadows are subject to a double whammy, because not only do they suffer worst from electronic noise, but they also bear the brunt of photon noise. Figure 2 is taken using a small exposure (low ISO) and the gradation of noise from the highlights to the shadows is apparent.



PATTERN NOISE Pattern noise is more properly called ‘pixel response non-uniformity’ (PRNU). It arises from the fact that the pixels in a sensor and the associated read electronics are not perfect. If they were, every one would be precisely the same, but in practice there are slight variations. Thus, rows and columns of pixels are likely to respond in slightly different ways,
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ALL IMAGES: RICHARD SIBLEY



200%



200% Fig 1



Fig 2



giving rise to a characteristic tartan pattern. PRNU is also more apparent in dark areas than in light ones, so the double whammy becomes a triple. Figure 3 shows typical pattern noise.



DEALING WITH NOISE The ﬁrst stage of dealing with noise is to have as little of it as possible in the original captured image. The factors under the photographer’s control are the amount of light and the ISO setting. As discussed earlier, the greater the exposure (where exposure means the density of light x time at the sensor), the lower the noise, so the goal is to have the biggest exposure, subject to the constraints of choosing a shutter speed to minimise motion blur and an f-number to get the desired depth of ﬁeld. Generally, you will get the biggest exposure by selecting a low ISO, but if you are using a manual mode, the exposure is actually independent of ISO and you can manipulate the relationship to reduce noise in two ways. One is to use the technique known as ‘expose to the right’ (see pages 12-13). Camera manufacturers usually build in a bit of extra light capacity in the sensor to cater for extended highlight headroom. If you know the exact extent of the highlights, that headroom can be used to gain more exposure.



‘Expose to the right’ means that the photographer examines the histogram resulting from a shot and increases the exposure until the highlights are as far as they can be ‘to the right’, meaning that all the available headroom has been used. The second technique, if you have a camera with falling electronic noise as ISO is raised, is to use a similar technique with the ISO control. In this case, increase the ISO until the histogram is ‘to the right’, meaning the ISO is as high as it can be without clipping highlights. Since this only improves the shadows, the ﬁrst technique, maximising exposure, should take priority. It should be added at this point that once a photographer has strayed away from the nominal exposure setting for the ISO, he or she is committed to producing an image from a raw ﬁle and processing speciﬁcally to get the correct tonality, otherwise these images will appear ‘overexposed’.



NOISE REDUCTION Noise and detail go together. If an image is smoothed to reduce detail, the noise will also be smoothed. This is one reason why cameras with low pixel counts may look ‘smoother’ – because they capture less detail. Noise reduction attempts to distinguish between the variation



Figure 2: Photon noise depends on the amount of light, so it is graded between low noise in the highlights and high noise in the shadows due to noise and the variation due to detail, and smooth only the noise. When doing this it looks for correlations in the variation. There is no correlation in random noise, so this can distinguish the two. Various noise-reduction techniques are available, and it is worthwhile experimenting with these to ﬁnd which one you like best as these things are subjective. Another subjective factor is that most detail is detected by the eye in the luminance of the image, which means that the colour channels may be subjected to aggressive ‘de-noising’ without too much visible loss of detail. This can be achieved by converting the picture to an LAB representation (Luminance channel L and chrominance A and B) and applying de-noising to just the A and B channels, before converting back to RGB (some de-noising systems do this automatically). Shadow noise can be dealt with simply by raising the black level. This leaves ‘plugged’ shadows, but they can be visually less objectionable than shadow noise. Pattern noise is trickier. Noise reduction does not affect it because it is non-random. The best
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Fig 3



Figure 3: Pattern noise (PRNU) produces characteristic banding or ‘tartan’ patterns way to remove pattern noise is to take a sample ﬂat, dark, grey frame, chosen to display pattern noise at about the same level as apparent in the image, and subtract that from the image, making sure alignment is precise. This is time consuming and error-prone, which is why many photographers choose cameras that are not subject to pattern noise in the ﬁrst place. The ﬁnal tweak is to apply different de-noising techniques to different parts of an image. For example, if the sky is noisy, a mask can be made according to the blue colour, and denoising applied only within the mask. Since the sky has no detail, that can be aggressive without affecting the parts of the image that do carry detail. ADVANCED PHOTOGRAPHY SKILLS 9
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USING NOISE-REDUCTION SOFTWARE Rather than spending money on noise-reduction plug-ins and standalone apps, why not try your raw converter? We explain how… A long exposure in low light has resulted in luminance noise, which has been made more apparent by the compensation needed to correct slight underexposure



ORIGINAL



ADJUSTED



50 LUMINANCE



100 LUMINANCE



Adjusting the Luminance slider shows the destructive impact this control has. Set to 50, detail is already compromised, and at maximum (100) it is blurred beyond recognition



ORIGINAL



FINAL



LUMINANCE NOISE CONTROL



0 DETAIL



100 DETAIL



0 CONTRAST



100 CONTRAST



The Luminance slider is used to remove greyscale noise that makes an image look ‘grainy’ THE LUMINANCE slider is Camera Raw’s master control for removing the underlying texture caused by greyscale luminance noise. This is the hardest type of noise to reduce, so the Luminance slider is the most destructive noise-reduction tool. Heavy use can quickly (and irretrievably) remove detail, so make sure you preview the image at 100% and scroll around to see what effect the noise reduction is having in various areas. Once you increase the Luminance slider’s value above 0, the Luminance Detail and Luminance Contrast sliders become active so you can ﬁne-tune the noise adjustment. If you increase the Luminance Detail value, areas of 10 ADVANCED PHOTOGRAPHY SKILLS



ﬁne detail will be retained, albeit at the expense of less noise reduction being applied to these areas. Lower values apply the noise reduction more uniformly, which reduces more noise but can obliterate ﬁne detail more quickly. Luminance Contrast affects the contrast of the noise: lower values result in a greater apparent reduction of noise, but also reduce overall contrast. The effect of Luminance Detail and Luminance Contrast adjustments can be subtle, depending on your image, but as a rough guide, the ﬁner the detail (and the more prevalent it is), the higher the value you need to set for both. For images with broad areas of similar tonality, lower values will prove more effective in reducing noise.



The effect of the Luminance Detail and Luminance Contrast sliders is less pronounced, as the details show
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Setting the Luminance slider to 25 and the Luminance Detail and Luminance Contrast sliders to 50 strikes the right balance between noise reduction and detail retention for this 20-millionpixel image from a Sony Cyber-shot DSC-RX100
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COLOUR NOISE CONTROL



THE PRINCIPLE behind using the Color slider is the same as that for the Luminance slider: the higher the value of the slider, the more aggressive the noise reduction will be. However, the effect of the Color slider is less destructive than the Luminance slider, and even very high values can be used without reducing image quality too much. Whereas heavy use of the Luminance slider will reduce detail, the Color slider will begin to desaturate the image, which can be more easily remedied. In addition to the main Color slider is the Color Detail control. This acts in much the same way as the Luminance Detail slider, with higher values reducing the effect of the Color slider in areas containing ﬁne detail. In doing so, edge detail is preserved (as the noise reduction is reduced in these areas), while broad areas of roughly the same tonality receive the full chroma noise-reduction treatment. Conversely, a lower Color Detail setting means that the noise reduction affects all areas more equally, so image detail, as well as chroma noise, is suppressed.



FINAL



ORIGINAL



ADJUSTED



This image was exposed to retain detail in the sky and the shadows were then lightened heavily in Camera Raw to bring back detail on the left. This has transformed the dark areas, as the chroma noise has been emphasised by the lightening process



TOP TIPS The amount of noise reduction required will depend on the scene, the image size and ISO sensitivity.



1 2



When you’re setting noise reduction in Camera Raw, zoom into the image so you are viewing it at 100% (actual pixels). At smaller preview sizes, the effect may not be shown accurately.



COLOR 10



COLOR 100



COLOR 50



Increasing the value of the Color slider has an immediate and obvious effect. At a setting of just 10, all traces of the chroma noise have gone so there’s no need to go any higher. You can see that setting the Color slider to 50 or 100 has no further effect



COLOR DETAIL 100



COLOR DETAIL 0



It is better to concentrate on removing chroma noise, and retain some luminance noise to avoid losing too much detail.



3 4 5 6



Colour-noise reduction can desaturate your images slightly, so be prepared to resaturate them if necessary. Noise reduction reduces sharpness, so is best combined with sharpening to compensate.



The Color Detail slider does need adjusting, though. At a setting of 100, distinct red pixels remain in the dark areas at the left of the shot as the processing attempts to retain detail (and sharpness). These are removed when the slider is decreased to 0, and in this instance the result is not overly soft. In the end, both the Color and Color Detail sliders were set to 50, with additional noise reduction applied to reduce the remaining luminance noise
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If removing the chroma noise in an image proves too problematic, consider converting to black & white – it will alleviate coloured noise immediately. ADVANCED PHOTOGRAPHY SKILLS 11
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RAW



JPEG



RAW -2EV



JPEG -2EV



SHOOTING TO THE RIGHT There is an easy technique to help you greatly reduce image noise, or even eliminate it – let more light into your images. We explain how



ONE OF the main causes of image noise is too little light reaching the photodiodes of an image sensor, as we have outlined on pages 7-9. Therefore, the amount of noise in an image can be reduced by increasing the light reaching the sensor. To increase the light you can either lengthen the exposure time or open 12 ADVANCED PHOTOGRAPHY SKILLS



the lens aperture. At this point, it is important to remember that the ISO sensitivity has no bearing on the issue. Unlike ﬁlm, where the chemical formulation can be changed to make it more or less sensitive to light, a digital sensor has a base sensitivity that never changes. All that happens when changing a camera’s ISO sensitivity is that either the analogue or digital signal produced by the sensor is boosted – the sensitivity of the sensor remains the same. Raising the ISO sensitivity of a digital camera actually causes the sensor to receive less light, as the metering compensates for the increase by reducing the exposure required. When shooting ﬁlm, this wouldn’t matter as the sensitivity of the ﬁlm would compensate, but with a digital sensor, boosting the signal also increases the underlying electronic noise caused by



the sensor. This reduces the signal-tonoise ratio, which causes the noise to become more apparent. This is why it becomes more visible as the ISO setting increases.



SHOOTING TO THE RIGHT You may have heard the expression, ‘shoot to the right’. In short, ‘the right’ refers to the right-hand side of a histogram. In other words, you are increasing the exposure to brighten the image, grouping the tones at the right-hand side of the histogram. This means that the shadows and midtones are also brightened, and it is these areas that are prone to noise. The trick is to increase the exposure as much as is possible without blowing out highlight detail, or at least making sure that minimal detail is lost. While a simple increase in exposure by around 0.7-2EV should be ample, it does,
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Above: While the JPEG image has blown-out highlights, as shown by the histogram, the raw image doesn’t



of course, depend on the scene. The best method of achieving this kind of exposure is to use the histogram display on the camera’s rear screen, and increase the exposure so that the curve is to the right of the graph but not completely bunched up towards the end. Even with the exposure pushed to the right in this way, it is still beneﬁcial to capture a ±0.3EV bracketed set of images. This is because most cameras will base the histogram on the JPEG image, or the JPEG preview image contained within a raw ﬁle, rather than the raw ﬁle itself. It is therefore important to shoot in raw capture so you can squeeze the most detail from the scene. Also, select the largest bit
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EDIT



1EV



EDIT



200%



200%



200%



200%



Brightening the image with the camera’s default metered exposure reveals noise in the shadow areas depth possible for you raw images (Nikon cameras, for instance, often have the option of 14-bit raw ﬁles, as well as 12-bit). Basically, when you shoot raw images, you will usually have more leeway in the highlights than the histogram (and the camera’s highlight clipping feature) may indicate. Therefore, if the histogram is on the verge of bunching up at the right-hand side, don’t be scared of pushing it just a bit further.



EDITING THE IMAGES With the exposure pushed as far to the right of the histogram as possible without clipping the highlights, the highlights and midtones will almost certainly be too bright and look



overexposed. As this technique is designed for raw images, this is not a problem. The purpose is to brighten shadows to reduce noise, while making sure there is detail in the rest of the image that can be easily recovered with raw-conversion software. When editing the raw image, the ﬁrst step is to reduce the exposure for the highlights. In Adobe Camera Raw, use the Highlights recovery slider to do this. Move the slider to the left to tone down the very brightest parts of the image, but not so much that the highlights become midtones. Similarly, the midtones may also need darkening slightly, which can be done by selecting the Tone Curve tab and then moving the Lights slider to the left. As the brightness of the image has largely been reduced, the noise in the highlights and midtones should be far less noticeable, if visible at all. The



Increasing the exposure just 1EV still retains detail in the highlights, but much less noise is revealed in the edited image shadows may still need to be lightened to bring out detail. However, as a brighter exposure has been used, less noise will be visible than if the image had been exposed with a default setting. Conversely, shadow areas may be quite bright, so they will need darkening. By darkening the shadows, any noise visible in these areas will also be hidden. So the next time you are taking an image that might be susceptible to noise, make the exposure as bright as you possibly can without causing large blown-out areas of white. The increased exposure, and the darkening of the image post-capture, will help to keep noise to a minimum, for smoother, cleaner images.
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TOP TIPS 1 Always capture raw images at the best bit depth available on your camera The in-camera histogram is only a guide An increase in exposure of just 1EV can make a signiﬁcant difference to the amount of noise Use your raw-conversion software’s highlight-recovery slider to pull back highlight detail



2 3 4
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STACK IMAGES TO REDUCE NOISE Although shooting at a low sensitivity is the best way to create a noise-free image, there is a way of reducing noise by using a high ISO setting and then stacking the images. We explain how WHEN shooting in low light, there is often no choice but to use a fast shutter speed and a high ISO. With this increase in sensitivity, noise will inevitably become an issue. There is, however, a way to reduce the noise that involves shooting the same scene in a quick burst. To perform this technique perfectly a tripod is required, but acceptable results can be achieved even when shooting handheld – provided a fast enough shutter speed is used and the photographer can maintain a reasonably steady hold. The ﬁrst step is to set the camera to its fastest continuous shooting rate. Generally, a minimum of four images are required, so a camera with a 5-6fps shooting rate should be ﬁne. It doesn’t matter too much whether you shoot in raw or JPEG format, but raw has the obvious advantage of giving you more control over your images.



BEFORE
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AFTER
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1



2



3



4



5



6



Open the images in Adobe Camera Raw and perform a basic edit to taste. Don’t apply any noise reduction or sharpening at this stage. Apply the same correction to each of the raw ﬁles.



With the images loaded as layers, click Edit>Auto Align layers. Photoshop will now automatically align each layer so that it matches.



Now the opacity of the layers needs to be adjusted. Turn all the layers on and leave the opacity of the bottom layer set to 100%. Each layer above this should be set to an opacity based on the following equation: layer opacity % = 100 x 1/(number of layers below + 1). For example, the next layer up should have an opacity of 100 x 1/(1 + 1) = 50%, the layer above that 100 x 1/(2 + 1) = 33%, the layer above that 100 x 1/(3 + 1) = 25%, and so on.



One you have ﬁnished editing the images, they need to be loaded into Photoshop as different layers. If you are using Adobe Bridge, click on Tools>Photoshop>Load Images to Layers, which will make the task easier.



If your editing software doesn’t have this facility, you can do it manually. To do so, reduce the opacity of the top layer to around 70% and then move the layer below until it is aligned with the top layer. Switch off the layer once it is aligned and then align the layer below with the top layer. Repeat this until each of the layers is aligned with the 70% opacity top layer.



The ﬁnal image should have signiﬁcantly less noise. Finish the image by selecting Layer>Merge Layers and then save the image as a TIFF ﬁle. The image can then be edited as normal.
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12 ESSENTIAL LANDSCAPE EDITING SKILLS Follow our expert photo-editing advice to produce the best possible landscape images



RICHARD SIBLEY



BEFORE
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AFTER
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TIP 1 LANDSCAPES EXPOSURE BLENDING



Learn to merge different exposures to create a blended image, without resorting to HDR toning



AFTER



An HDR merge does not work well for moving objects, such as the ﬂag in this scene, for which an exposure blend is better. In Photoshop, choose File>Automate>Photomerge from the top menu. Click browse and import the bracketed images. In this case there are ﬁve. In the Layout options, select Auto if it is not already selected and then ensure the Blend Images Together box is unchecked. Hit OK.



Photoshop combines the images into one ﬁle, with each of the ﬁve exposures as a layer. Order the layers with the mid-exposure as the base layer and then, in order, the darkest up to the lightest exposure at the top. In the Layers palette, select each layer in turn, clicking the Add Layer Mask icon to add a mask to each layer. The masks are white. For all but the base layer, invert them to black (Ctrl/Cmd+I).



2



White masks reveal and black masks conceal. All we see, then, is the base mid-exposure. We need to ‘paint in’ the darker and lighter exposures over the base layer to extend the tonal range. Select the Brush from the Tools palette and set the foreground colour to white to paint onto the layer. The brush size can be changed to deal with larger or smaller areas. Begin bringing in the dark exposure.



Overall, painting onto the layer is a slow process. Any mistakes that are made can be painted back in by switching the foreground colour to white or going back to previous steps in the History palette. Changing the opacity of the brush to around 30% introduces the layer more gradually. I have painted in the lightest layer for the sunlit building, the darkest layer for the sky and the middle layers for midtones.



To add a little punch to the sky, I can introduce a Curves adjustment to the darkest exposure layer. With the dark layer selected, click on the New Adjustment Layer icon in the Layers palette and select Curves. When satisﬁed with the results, ﬂatten the image (Layer>Flatten Image) and, if the original merge process has thrown the frame edges out of sync, crop the edges to tidy them up.



1



BEFORE



4



3



5
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TIP 2 GENERAL DODGE AND BURN The Dodge and Burn tools can add drama to many a landscape



1



Once all the midtones have been lifted to your satisfaction, go back to the top bar and select Shadows. I want dark areas of the sky to be even darker to add drama, so I have selected the Burn tool. Again, paint in the effect slowly over the darker areas. Making other shadow areas darker will improve the overall contrast of the scene. However, I want to lift the shadows in the posts on the jetty, so I switched to the Dodge tool to paint the effect in.



2



TIP 3 GENERAL ENHANCE COLOURS We explain how the Selective Color tool can enhance individual colours



Some, but not all, of the colours in this image could do with added vibrance to make them ‘pop’. In the Layers palette, click on the Create New or Fill Adjustment Layer and choose Selective Color. In the properties box, a colour channel will appear. In this case, I selected green as the primary colour and then adjusted the sliders to get the right tone. Adding to the black slider gives greater vibrance to that colour.



1
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AFTER



Return to the top bar and select Highlights. I want to make parts of the sky and the snow-capped mountains ‘pop’, so reselect the Dodge tool. The effect is clear, so I shifted the Exposure down to 1%. Again, patiently paint in the dodge effect over the highlights. At any point you can click on the visibility of the layer to see the original image. Using the precise Dodge and Burn tool requires time and patience to build up its darkroom effect.



3
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The tone in this landscape is ﬂat and could beneﬁt from a lift. As the Dodge and Burn tools are destructive, it is best to work on a layer (Layer>Duplicate layer). Select the Dodge tool from the Tools palette, then in the top toolbar select Midtones and adjust the Exposure to under 5%. Paint over the midtones that need a lift – in this example, the jetty. The effect is subtle as it builds up, but after each pass with the tool undo the step (Ctrl/Cmd+Z) to see the difference.



BEFORE



AFTER



BEFORE



For any other colours that need enhancing, repeat the process from the primary colour part. For example, there are some pink ﬂowers that can be enhanced by working on the magenta primary colour. Now, in the Layers palette again, change the mode from Normal to Overlay. The contrast of the image will now be too great. Switch to Overlay layer mode and reduce the opacity to taste, in this instance down to 28%.



2
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Some tones in the image are a little ﬂat or could do with a lift, particularly the shadows. The overall levels of the image can be adjusted, again via Create New or Fill Adjustment Layer and choosing Curves. Adjusting the curve a little brings some detail out from the shadow areas. Once the image looks good, ﬂatten it (Layer>Flatten image) and save a new copy.
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AFTER



TIP 4 LANDSCAPES POLARISED EFFECT



This effect is best applied in Adobe Camera Raw or similar raw-conversion software. Start by using the Highlights (named Recovery in older versions of Camera Raw) to darken the highlights in the sky. You may also wish to use the Clarity slider to add some local contrast to the image, which can help bring out some detail and shape in the clouds.



1
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Replicate the effect of using a polarised ﬁlter to create a blue sky



Go to the HSL panel and select Luminance. Move the Blues slider to the left to reduce the brightness of any blue colours in the image.Obviously, you don’t want to go too overboard with the effect, especially as it may affect other areas of blue in the image.



2



With the blue sky darkened, switch to the Saturation tab and slightly increase the saturation of the blue colours. Don’t apply this effect with a lot of strength as it can create a solid block of blue colour rather than a natural gradient. Finally, ﬁnish off by making any further brightness and contrast adjustments to taste.
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TIP 5 LANDSCAPES SMOOTHER SKIES Reduce luminance noise in a sky using raw-conversion software



This is another effect applied in Adobe Camera Raw or similar raw-conversion software. Edit your image as usual, but apply only a very basic hint of sharpening. Concentrate on the contrast and the exposure of the image.



1



BEFORE



AFTER



Using the Adjustment brush, paint the sky. Use a large brush with a soft edge so that it fades slightly with the landscape. Now reduce the Clarity slider and Sharpness. Combined with a fairly strong application of the Noise Reduction slider, this should be enough to smooth the sky. Zoom in to 100% to check that the luminance noise has been smoothed. You may want to add some contrast back into the sky if it has become ﬂat.



2



Now create another local adjustment mask and apply the corrections you usually would to the foreground. Here I have increased the Clarity slider to add some local contrast, as well as a touch of sharpening. Once ﬁnished, zoom out to see the overall effect and make any further edits. The sky should be smooth, but the foreground still full of detail.
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TIP 6 LANDSCAPES RECOVERING HIGHLIGHTS



1



The highlight detail has now blown out, but because it was there to begin with, it can be recovered. Bring the Highlight slider down until the information on the histogram has returned (the white arrow disappears). In this extreme example, the slider needs to be reduced to -60, but at its minimum -100 setting the sky looks best.
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TIP 7 LANDSCAPES DIGITAL ND GRAD We explain how to create an ND grad ﬁlter effect using the Gradient tool



An ND grad ﬁlter effect can be applied to a single image. Create a copy of the original image by selecting Layer>Duplicate Layer and name the new layer ‘ND Grad’. With the new layer selected in the layers panel, use the Levels tool to darken the image until the contrast and exposure in the sky are just right.



1
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A dark exposure usually has more muted colours and can appear a little ﬂat after being brightened. A bit of vibrance and punch need to be introduced via the Vibrance, Saturation and the Contrast sliders. I have pushed the Contrast to +20, the Saturation to +6 and the Vibrance tto +25. The ﬁnal result is a subtle HDR-type effect. Be careful not to push the sliders too far as the ﬁnal effect can end up on the unwanted side of HDR – garish and ﬂat.
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AFTER



BEFORE
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Detail that simply isn’t there, such as burnt-out highlights (pure white), cannot be restored. However, available tonal detail can be enhanced using the exposure sliders in Adobe Camera Raw. This landscape has been shot with a dark exposure to maintain detail in the brighter sky, but the overall exposure is too dark. Brighten the Exposure slider until the land area looks just right. In this case, I have brightened it by +2EV.



AFTER



BEFORE
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How to brighten an exposure, then recover highlights in Camera Raw



In the Layers palette, create a new Layer Mask for the ND Grad layer. Now select the Gradient tool from the Tools palette and choose a black-to-white gradient. It is the Gradient Fill tool that adds the black-to-white gradient on the ND Grad layer. The dark side of the gradient creates a transparent area of the ND Grad layer, which consequently reveals the original, lighter layer underneath.



2
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Click and drag the gradient vertically up the image to create the dark side of the gradient on the bottom of the frame. Holding down the Shift key while drawing the gradient line keeps it at 90°. The longer the line, the softer the gradient; the shorter the line, the harder the gradient. The effect can be toned down by reducing the opacity of the ND Grad layer. Once done, ﬂatten the image (Layer>Flatten Image) and save a new copy.
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TIP 8 GENERAL PERSPECTIVE CORRECTION How to transform and warp an image to correct perspective



CALLUM MCINERNEY-RILEY



BEFORE



AFTER



With the image open, go to View>Rulers. This is used to measure and align the image. Create some visual markers to help in your correction by clicking and dragging from the centre of the rulers. Drop these guides in a place that suits your image – putting guides over horizons, buildings and straight points is best.



1



Next, level the horizon using the guides as a visual reference. Go to Select>Select All to select the entire image, then Edit>Free Transform. A box will appear, and by positioning the cursor outside the box you can rotate the image until it is straight. When ﬁnished, hit Enter to conﬁrm the transformation.



2



3



By now the perspective of the image should be improved, but often there will still be some problematic areas. Go to Select>Select All and then Edit>Transform>Warp. A grid will appear: clicking and dragging short distances on speciﬁc areas will allow you to bend parts of the image into a desirable position.



Finally, after heavy transformation you will often ﬁnd that the image doesn’t ﬁt the original canvas. To rectify this, simply click on the Crop tool and crop into the picture until the entire image ﬁlls the crop area. To remove the guides, go to View>Clear Guides.



4



To correct perspective, go to Select>Select All (if previous selection is still live, click Select>Deselect ﬁrst). Go to Edit>Free Transform. A box will appear with points in the corners and at the sides. Control these individually by holding Cmd/Ctrl and clicking on them. Drag the points and use the guides to align the straight verticals. Hit Enter to conﬁrm transformation.
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TIP 9 GENERAL SELECTIVE SHARPENING



With your image loaded in Photoshop, duplicate the layer by selecting Layer>Duplicate Layer. Now use the Magnify tool in the Tools palette to zoom in on the area you wish to sharpen. In this case, it’s the car.



1



AFTER



BEFORE



With the duplicate layer selected, go to Filter>Other>High Pass. Gradually increase the strength of the Radius setting until the details that you want to be sharper are revealed. Take care not to increase the noise too much, and try to avoid creating a strong halo effect.
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How to use the High Pass ﬁlter to sharpen part of an image



Now use the Color Picker tool to select a 50% grey colour from the Color Swatches palette. Paint grey onto the areas that you don’t wish to be sharpened. You can even vary the sharpening effect by changing the brush to an Opacity of 10% and slowly building up the effect. Once you have done this, change the blending mode of the High Pass layer to Overlay in the drop-down menu to reveal the ﬁnal image.
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TIP 10 GENERAL SELECTIVE EXPOSURE



Open your image in Photoshop and duplicate it by selecting Layer>Duplicate Layer. This technique is often best used to create a darker sky, so we will darken the sky in the version of the image created on the new layer. Do this using the Curves tool (Image> Adjustment>Curves…) Aim to make the sky darker, but retain some highlight detail in any clouds. Alternatively, you can use two different bracketed images – exposed for highlight and shadows.



1
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AFTER



BEFORE



Create a layer mask on the adjusted top layer by clicking on the layer mask icon at the bottom of the Tools palette. Once the layer mask has been added, click on it to select it so it can be worked on.



2
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Use multiple layers and different exposures to adjust selected areas



By painting using black onto the layer mask you are effectively cutting a virtual hole in the mask, revealing the layer below. Change the Opacity of a black brush to around 10% and slowly paint the areas of the image you wish to be lighter. The layer below will reveal itself gradually, giving you the best combination of the two images. If you make a mistake, simply use a white brush to paint the mask back on.
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TIP 11 LANDSCAPES REMOVE SMALL OBJECTS



The Clone Stamp and Healing Brush tools are widely used for removing small objects from a scene, but the Patch tool also works well and is generally a quicker method. Distant sheep and small objects in the grass litter this landscape, detracting from the main subject matter. Start by making a duplicate of the original image (Layer>Duplicate Layer). Select the Patch tool from the Tools palette and then draw around the object that needs to be removed.



1



AFTER



BEFORE



Right-click (PC) or Ctrl-click (Mac) inside the selection area and select ‘Use Patch as Source’. Click and drag the selection area to a nearby part of the frame – in this case a clean patch of grass. The object has been removed.



2



TIP 12 LANDSCAPES REMOVE LARGE OBJECTS
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We explain how to use the Patch tool to remove small objects



Images like this one have several objects to remove, so repeat step two until the objects are gone. For trickier selection areas, such as the lake at the rear of this scene, you may need to use the Clone Stamp tool to tidy up any misaligned areas. Select the Clone Stamp tool from the Tools palette and hold Alt and click to select the surrounding area to clone from, then use this to tidy up any misalignment.
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AFTER



BEFORE



Content-Aware Fill is useful for removing large unwanted objects from an image, such as the plastic bin in front of the beach huts in this scene. It is best to work from a layer (Layer>Duplicate Layer). Depending on the object that needs removing, select the appropriate Lasso tool from the Tools palette. I have used the Magnetic Lasso tool because the bucket is distinguishable from its surroundings. Select the immediate area around the object.



1



With the mouse inside the area selection, right-click (PC) or Ctrl-click (Mac) and select the Fill option. In the Contents box under Use, select the ContentAware option, keeping the Blending Mode to normal and Opacity at 100%, then click OK. The area has now been ﬁlled in. Content-Aware Fill can be hit and miss. If the new content is clearly wrong, undo the step, reselect the area and try again. The bucket has been removed in this image, but it needs tidying up.
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Content-Aware Fill can be used to remove an unwanted object



Before tidying up the new content, ﬂatten the image (Layer>Flatten image). The Clone tool (Clone Stamp tool) is ideal for minor alterations, such as lining up the wooden rails of the beach hut that are slightly out of line. Select the Clone tool from the Tools palette, then hold Alt and click to select the appropriate surrounding area to clone from and tidy up the content.
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LIGHTING GELS



LIGHTING GELS Lighting gels are coloured transparent sheets used to alter the colour of a light source. They are called gels because



for years gelatine was used in their manufacture. However, as the gels have to withstand the extremely high temperatures created by continuous lights used in photographic, theatre and television productions, they are now manufactured from various heat-resistant plastics. As the size of lighting gel required depends entirely on the type of light with which it will be used, gels usually come in rolls or sheets that are then cut to the correct size. This is especially true in photography, where often only a very small amount of gel is required for use with a hotshoe ﬂashgun. For this reason, many manufacturers offer small kits for photographers with a number of differentcoloured gel swatches. Despite being manufactured from materials designed to withstand very high temperatures, lighting gels do wear out over time. The colour can begin to fade and the material can become quite brittle and just ﬂake away.
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One of the cheapest lighting accessories can also be the most useful. We explain how to get the most from a simple set of lighting gels APART from a softbox, the most useful accessories that I have for my small lighting kit are different-coloured lighting gels. However, mention lighting gels and many photographers will think of images seen in photography books from the 1970s and ’80s, where portraits were lit with blue- or red-coloured lights – and sometimes even both. This garish style looks very dated, and has probably deterred quite a few photographers from ever buying a set of lighting gels. Yet these gels are useful for a variety of different purposes, and are one of the cheapest accessories available. There are basically three ways that lighting gels can be used: for colour



correction; to create a special effect; or to simply illuminate an area or subject with a particular colour. The key to using lighting gels well is to use them subtly and in moderation. Unless you are using a lighting gel for colour correction, there are few times when the coloured light should be the dominant illumination in an image. Over the next few pages, I will explain exactly what lighting gels are, and how and when to use them.



WHAT IS A LIGHTING GEL?



LIGHTING GELS
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FLASH WB



TUNGSTEN WB AND GEL



TUNGSTEN WB



COLOUR-CORRECTION GELS SOME of the most useful types of lighting gels are those that alter the colour temperature of a light so it replicates another light source. While these are also possibly the least exciting, they can make a crucial difference to images lit with multiple sources of light. For example, using ﬁll-in ﬂash in a tungsten-lit room means there will be two light sources illuminating the scene, each with a different colour temperature. The tungsten light will be an orange colour, while the ﬂash will be very blue in comparison. Setting the camera’s white balance to tungsten will add blue to the image to neutralise the orange colour of the tungsten lights. However, in doing so, the added blue will also exaggerate the blue light from the ﬂash, which can be very unﬂattering when using ﬁll-in ﬂash for portraits, producing a cold, pale-looking complexion. However, by using an orange colour-correction ﬁlter over the ﬂash, the light it emits will be orange and will match the colour of the tungsten light in the room. Setting the camera’s
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COLOUR-CORRECTION CHART Ambient light



Flash gel



Number



Camera WB



Tungsten



Full CT Orange



204



Tungsten



Outdoor street lamps



Urban Sodium



652



Custom WB



500W studio tungsten



Quarter CT Orange



206



Tungsten



Fluorescent



Half Plus Green



245



Fluorescent



white balance to tungsten will then neutralise the orange light from both the tungsten lights and the ﬂashgun, creating a perfectly neutral image. Another example might be when



taking images outside at night. Streetlights produce a very orange/ amber-coloured light. If you are taking a portrait of someone using ﬂash, with the camera’s white balance Top: Lit using both tungsten light and fill-in flash, there is a big difference in white balance across the scene. Using a tungsten gel over the flash means it matches the colour of the tungsten lamp, leaving no colour cast when the tungsten white balance is used Left: Some flash gel kits have Velcro fixings so they can be easily attached to your flashgun
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set to ﬂash, then the subject will look neutral, but the background will be a deep amber colour. Instead, using a deep amber ﬁlter and setting the camera’s white balance to tungsten, or an even stronger custom setting, will make both the subject and the background neutral. Blue colour-correction gels work in a similar manner. A good example is when people wish to mix continuous tungsten lights and ﬂash in the studio. Instead of putting the orange gel over the ﬂash, blue gels can be used with the tungsten lights to help match their light to the colour of the ﬂash output. Fluorescent lighting is a little trickier to compensate for, as the exact colour of the light can vary as the bulbs or tubes heat up, and depending on which gas is used inside. As a general rule, most ﬂuorescent lights emit a green hue. A green colour gel over a ﬂash will therefore match it to this light, enabling the ﬂuorescent white balance setting to be used on the camera for an even colour temperature across the image. Colour-correction gels are available in different strengths, usually measured in 1/4, 1/2 and full, to match the colour temperature of different strengths of light. To get an exact colour match, it may be necessary to combine different ﬁlters. For example, combine 1/4 and 1/2 gels to make a 3/4 gel, for those times when a full gel is just a little too much. Similarly, some lights may just have a slight hint of another colour, such as certain types of street lamp. In these instances, try using a full orange gel combined with another slightly pink gel to recreate the hue of the light. There are hundreds of different colours and strengths of gel available, and manufacturers will often have sample swatches that can be purchased to try out. The table above contains some of the most common types of colour-correction gel and the product numbers from the most popular manufacturers.



WorldMags.net MEASURING COLOUR TEMPERATURE It is usually quite easy to ﬁnd out the colour temperature of lights that are used for photography. Most manufacturers will list the colour temperature of ﬂashguns, studio ﬂash heads and continuous lights in each product’s speciﬁcation – after all, it is in their interests to make this information available. When it comes to balancing different types of light, it is therefore quite easy to work out roughly which gels to use, but for absolute precision the exact colour temperatures are necessary. Lee Filters has a handy calculator on its website that allows users to select the colour temperature of the light source to be ﬁltered, and then the colour temperature of the light that is to be matched. It then displays the colour ﬁlter gel, or different combinations of gels, that can be used to match the light sources. The gel calculator is free to use and is available at www. leeﬁlters.com/lighting/mired-shiftcalculator.html. With traditional tungsten light bulbs now being replaced by energy-efﬁcient ones, it is a little more difﬁcult to know the colour temperature of the newer kind. Older types of energy-efﬁcient bulbs have the same colour temperature as a standard ﬂuorescent lighting tube, while others are designed to produce a cool daylight colour. However, most current household energy-efﬁcient bulbs try to replicate the colour of a tungsten bulb. When shooting with these bulbs, it is important to allow them to warm up fully to reach their peak operating temperature, as the colour of the light will change as this takes place. The white balance of these bulbs is sometimes featured as a Kelvin value on the box, or included in the instructions. Failing that, the speciﬁcation is often available from the manufacturer’s website. It is also possible to ﬁnd out the exact colour temperature of a light using a digital camera. Using only the light source to be measured, hold a grey card under the light and use the camera’s custom white balance feature to take a colour reading from the light. Usually, the exact Kelvin value of the light source will be set and should be shown when looking at the image information on the camera screen. If the custom white balance value is not apparent, open the raw ﬁle in raw-editing software and it can be seen there. Once this value is known, the Lee Filters calculator can be used to calculate the ﬁlters needed to match a ﬂash to this light.



TOP TIPS



LIGHTING GELS



DEEP GOLDEN AMBER 135 GEL



Use the custom white balance to ﬁnd out the exact colour temperature of a light source



1 2 3



A grey background can be easily coloured using a ﬁlter gel



SKY BLUE 068 GEL



Remember to think about how the colours of the gel will work with other colours in the image. Try using complementary colours together



4 5 6



Keeping a basic selection of colour-correction gels with your ﬂash is extremely useful Gels can reduce the ﬂash output, so make sure that this is factored into the exposure



Certain coloured gels can be used to replicate certain types of light, such as a sunset or moonlight



USING COLOUR GELS FOR EFFECTS WITH such a huge number of



WHERE TO GET THE GELS LEE FILTERS www.leefilters.com. Manufacturer of lighting gels LUMIQUEST www.snapperstuff. com. Manufacturer of a number of kits to enable the use of filters on flashguns. Distributed in the UK by Snapper Stuff HONL www.flaghead.co.uk. Honl makes the lighting gel kit pictured on page 26. Distributed in the UK by Flaghead Photographic ROGUE www.daymen.co.uk. Manufacturer of the Universal Flash Gels Kit. Distributed in the UK by Daymen



coloured gels available, many are used for special effects. For example, a Deep Golden Amber 135 gel may be used to replicate a vivid sunset. By placing the ﬂash at a low angle to light the subject in a room, it can look like the light from a sunset pouring in through a window. At night-time, or on an overcast day, the ﬂash can be placed outside a window, with the window frame creating strong shadows across the subject. This effect can even be recreated without actually needing a window.



Use a large sheet of black card and cut out a simple frame to give the impression of window light falling onto the subject. Alternatively, try cutting strips out of the card to create a Venetian blind effect. Both techniques will make it appear as though the subject is sitting next to a window at sunset. However, it isn’t just sunsets that can be recreated using lighting gels. A Sky Blue 068 gel gives the appearance of moonlight. Use the same technique as for the sunset effect, except place the gelled ﬂash higher and angled down at the subject.



Above: Gels can be used to create different effects. Here a warm orange gel used over a lamp at a low angle gives the feel of sunrise or sunset, while a cool blue gel used on a light at a high angle replicates moonlight



ROSCO LIGHTING GELS www.rosco.com/uk. Manufacturer of lighting gels SILVERPRINT www.silverprint. co.uk.Has a good selection of Lee Filters in both rolls and sheets
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LIGHTING A BACKGROUND ONE OF the best uses for a lighting gel is to change the colour of a background. The opening image of this article (page 25) was taken using a ﬂash with a blue lighting gel and pointed at a plain-black cloth background. The touch of colour adds more depth to the image than if it had been simply shot against black. The colour was chosen because it matched the subject’s clothing. When using coloured gels in an Altering the strength of the flash means that many different hues can be created from each single-coloured gel
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image, it is important to think about the colours already present in the scene. For subtlety, use matching or complementary colours to light a background, although colours can be made to clash if the image requires it. The beauty of using coloured gels is that simply switching gels can completely change how an image looks, so try experimenting with a few different colours. To light a background with a



WorldMags.net gelled ﬂash, try to make sure that the background is neutral. Although black and white backgrounds can be transformed into a different colour, they may still leave dark black areas, or bright white hotspots when white paper is used. For this reason, a grey background is often the best choice. With just a few differently coloured ﬁlter gels, it is possible to turn a grey background into many different coloured hues without going to the expense of buying separate coloured backgrounds. Remember that gels can be mixed together, so a combination of red and blue



gels will turn the light purple. This ability to combine different-coloured ﬁlters is why it is useful to have a basic set of primary and secondarycoloured gels, as well as a set of colour-correction ﬁlters. Mixing gels isn’t the only way to alter the colour of a ﬁlter. When lighting a background, adjust the brightness of the colour by altering the power of the ﬂash. Lowering the ﬂash power will make the colour darker, while increasing it will make it brighter. With just one grey background, you can see how it is possible to create a range of colours.



LIGHTING GELS



This is the set-up for the images below, with the flash behind the orchid pointing at a grey background. You can see the wide range of colours that are possible
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LONG EXPOSURES While patience and understanding are key to capturing any stunning longexposure image, many other considerations can make it a daunting process. We explain what’s involved and how to do it right



When shooting people in a long-exposure image, it is possible to make them appear ghostlike if they aren’t in the same position for the entire duration of the exposure Canon EOS 5D Mark II, 16-35mm, 129secs at f/19, ISO 50



MOST of us are familiar with longexposure images. Whether it is the swirling lights created by trafﬁc in a city at night, or the water of a ﬂowing river, long exposures have been used by photographers to capture patterns and movement over a greater-than-usual period of time. When talking about long exposures, we generally mean images that have been exposed for longer than 1sec. However, it is not uncommon to use exposures of minutes or even hours to capture a subject’s movement. The length of time used to create the exposure is one of the key



Although this is fairly slow for a shutter speed, it is not long enough to effectively capture the movement of people walking past, let alone clouds drifting through the sky. It is essential, then, to have some way of blocking or reducing the light entering the lens. This can be achieved using a neutral density ﬁlter. For the uninitiated, ND ﬁlters are slightly opaque ﬁlters with a neutral grey tint. They are available in different strengths and are designed to ﬁlter the light entering the lens. By hindering the light, they increase the length of exposure



considerations for the photographer, and can be difﬁcult to work out. This article will explain the principles, techniques and equipment needed for long-exposure photography. It is not simply a matter of mounting the camera on a tripod, setting a long exposure and then waiting patiently – if only it were! To capture the best-possible images, there are many small factors to consider, each of which will affect the outcome.



EXPOSURE TIME The correct exposure can vary hugely, depending on the intended subject



matter. For example, to capture the movement of people walking through a scene will require an exposure of only a few seconds, while photographing the appearance of stars travelling across the night sky will take a number of hours. The key to a good long-exposure image is therefore to set the correct exposure time for the subject. This ‘correct’ exposure time will be affected by the amount of light in the scene and the exact movement of the subject. In bright sunlight and using a standard lens, the slowest possible shutter speed may only be 1/30sec.
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CALCULATING THE EXPOSURE MOST cameras ﬁnd it difﬁcult to meter through a dense ND ﬁlter, and many won’t be able to expose the image correctly. It’s best to take an image normally and obtain a precise exposure without the ﬁlter. From this, the correct exposure for the ND ﬁlter



that is required for a wellexposed image. See About ND ﬁlters (opposite page) for more information.



A beanbag attached to the hook on the centre column of a tripod can help to weigh it down, while a remote trigger, such as the ioShutter iPhone app, makes sure you don’t move or knock the camera when firing the shutter



Apps are available to help calculate the correct exposure when using an ND filter



SECURING THE CAMERA While capturing the motion of the subject is the point of a longexposure image, one thing to be avoided is camera movement. Camera shake can ruin hours of work, so it is vital to keep the camera absolutely still – and a good tripod is essential for this. When the shutter is open for minutes at a time, the camera will be affected by even the slightest movement, so the tripod legs and head must be extremely secure.



If you plan to take a long exposure over a period of minutes or hours, it is advisable to check all the locks on the tripod legs and head. Make sure they are tight and secure, and that they won’t slip during the exposure. Sometimes even the sturdiest tripod needs a helping hand. In windy conditions, remove the strap from the camera. This can often end up blowing in the wind, and even the slightest movement from



THE VAST majority of cameras



FIRING THE SHUTTER



The ioShutter and accessory cable can be used to time the exposure and fire the shutter
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can then be calculated. All you do is double the exposure time for each exposure value. For example, for a standard exposure of 1/8sec, the correct exposure with an ND2 ﬁlter will be 1/4sec. With an ND4 ﬁlter this becomes 1/2sec, and 1sec with an ND8 ﬁlter. With a 10EV ND ﬁlter, the 1/8sec standard exposure becomes 2mins. Of course, it is easier to print out a chart of shutter speeds at different EV strengths. Also, there are smartphone and tablet apps, such as the Longtime Exposure Calculator (left), which is free for use with Apple iPhones and iPads. Simply enter the regular exposure and intended ﬁlter, and it will provide the correct exposure.



will have a maximum shutter speed of only 30secs, and this is ﬁne for many types of long-exposure image. However, shooting star trails will require far longer exposures, and this is where the bulb (B) setting comes into play. When in bulb mode, the camera’s shutter will remain open for as long as the shutter button is held down. This will require the photographer to time the duration of the exposure, but extreme precision is less important when the exposure time is minutes rather than a fraction of a second. That said, it is very important to keep the camera as still as possible, so be sure to avoid all
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contact as even the faintest camera movement could blur the image. As such, it is essential when using the bulb mode to use some sort of remote release. Many remote releases have a built-in bulb lock. This will open the shutter and begin the exposure on the ﬁrst press of the remote button, and close the shutter and end the exposure on the second press. Time the exposure using a watch so that the shutter is left open in bulb mode for the correct length of time. Most manufacturers offer advanced timer-control releases that will allow a precise length of time for a given exposure, so that it is no longer necessary to switch the camera on and off. These remote controls can be expensive, though, with such examples as the Nikon MC-36 and Canon
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WorldMags.net this can cause the camera to vibrate and result in a blurry image. It is also a good idea to weigh the tripod down with some ballast. Some tripods include a hook on the end of the centre column, from which a beanbag can be hung. This extra weight will help to prevent smaller movements, but be careful that the beanbag itself doesn’t add its own movement by swinging in the breeze. If there is no ballast hook, try placing a beanbag ﬁlled with rice on top of the camera during the exposure – this can also help to reduce the effects of mirror slap. One factor often overlooked is the ﬁrmness of the ground on which the tripod will stand. For example, when shooting a long-exposure seascape on sand, the tripod legs will sink into the sand over just a short period of time. Instead, try to ﬁnd a solid surface, or consider putting down a blanket under the tripod legs and then pushing down ﬁrmly, to help prevent further sinking.



FOCUSING Trying to ﬁnd the correct focus point when shooting long exposures can be problematic. In low light, it may be necessary to use a torch to help correctly focus the camera. However, this is further complicated if a ND ﬁlter is involved – even in the brightest sunshine, most DSLRs will not be able to focus while using a 10EV ND ﬁlter. So it may be worth switching to live view mode, as some cameras will still be able to focus in this way. It is far easier, though, to focus the lens and then lock it into position by switching to manual mode, before then carefully attaching the ND ﬁlter.



TC-80N3 each costing more than £100. Less expensive third-party versions are also available, and there are even more economical solutions available in the form of remote releases that work via a smartphone. Triggertrap Mobile (around £35) and ioShutter (around £60, pictured left) work using a lead that runs from the headphone socket of a smartphone, and which connects to a camera’s remote release cable. Downloading the accompanying app will allow the smartphone to become a sophisticated camera remote release. Simply dial in the length of time for the exposure and press the virtual shutter button on the app. Provided the camera is in bulb mode, the app takes care of the length of the exposure, and opens and closes the shutter.



ND filters come in different strengths and can even be combined



ABOUT ND FILTERS If you plan to take long-exposure images, you will need a neutral density filter. We take a look at the different types



ND ﬁlters



experiment with a shallow depth of ﬁeld when using a long exposure.



Neutral density ﬁlters come in different strengths that block different amounts of light, and therefore affect the length of the required exposure. The strongest ﬁlters increase the necessary exposure time by 10EV. Different manufacturers have different ways of naming their ND ﬁlter ranges, so we have included the table below as a reference:



Stacking ﬁlters By stacking ND ﬁlters together, their strengths can be combined. For example, two ND32 (5EV) ﬁlters will combine to produce the same result as an ND1000 (10EV) ﬁlter. This is useful when a precise exposure duration is required, or if one 10EV ND ﬁlter is too strong. Two 10EV ﬁlters can also be stacked to create a 20EV ﬁlter, for a very extreme result. For example, our 1/8sec original exposure, which becomes a 2min exposure with a 10EV ND ﬁlter, becomes a 2,048min (34hrs and 8mins) exposure with a 20EV equivalent ND ﬁlter set. The 20EV ﬁlter combination allows the user to shoot with a very shallow depth of ﬁeld on a bright day – a 1/4000sec exposure allowing, say, a f/2.8 aperture in sunshine, would become a 4min exposure with a 20EV increase. It therefore offers the chance to



to white-balance shifts. More signiﬁcantly, when they are used at maximum strength, a dark ‘X’ shape appears across the frame. While a ﬁlter may be advertised as, say, a 10EV variable ﬁlter, the reality is that it can only really be used with a smaller 2-8EV range. The cheaper ﬁlters can also degrade image quality. While these ﬁlters are useful tools, anyone thinking of purchasing one should do so from a reputable manufacturer. An alternative is to use two linear polarisers together and rotate one, but be aware that some strange colour shifts and a loss in image quality may result, depending on the quality and the strength of the effect used.



Variable ND ﬁlters The past few years have seen the release of a few variable ND ﬁlters, which are essentially two polarising ﬁlters placed together. By turning one of the ﬁlters, the polarisation causes light to be blocked. A different amount of light is blocked according to the angle of rotation, so the strength of the ND effect can be varied. The problem with variable ND ﬁlters is that they are more prone



Filter



Reduction (EV)



Density



ND2



1



0.3



ND4



2



0.6



ND8



3



0.9



ND16



4



1.2



ND32



5



1.5



ND64



6



1.8



ND256



8



2.4



ND500



9



2.7



ND1000



10



3.0
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SHOOTING IN THE DAY people will turn to ghostlike ﬁgures as they move around during the course of a long exposure. These movements are also nicely juxtaposed with other people in the scene who are standing still. The classic example of this is commuters waiting at a train station while other people rush past them trying to catch their trains. The problem here is that as the exposure lengthens, any people moving in the scene will become fainter and fainter, and will be at risk of disappearing altogether if the exposure time is in minutes rather than seconds. To capture the movements of people passing by, exposure times of between 5secs and 20secs are best. This duration should ensure that anyone moving in the scene will remain in the frame for the length of the exposure, and that their movement will be captured in the image.



During the day, moving clouds can create interesting ‘streaks’ across an image Canon EOS 5D Mark II, 16-35mm, 30secs at f/11, ISO 100



© STUART CLINTON



YOU CAN take long-exposure images during the day using a 10EV ND ﬁlter. With this ﬁlter, it should be possible to take images with exposures of 30secs or even longer, depending on how bright the light is. Although subjects are perhaps a little more restricted when shooting long-exposure images during the day, there are still plenty of interesting photo opportunities. For one of the most striking long-exposure photographs, try capturing the movement of clouds. Over the course of a 30sec exposure, clouds will appear to bend and stretch as they move across the sky. This works particularly well with white ﬂuffy clouds against a bright blue sky, and many photographers then convert these images into black & white to darken the sky and create dramatic highcontrast images. Another favourite daytime subject is the movement of people. Busy locations such as public squares, or commuters on their way to work, make for interesting scenes. Buildings in and around the scene will remain completely sharp and in focus, while



Traffic trails are one of the most common night-time long-exposure images Canon EOS 5D Mark III, 17mm, 30secs at f/22, ISO 100



SHOOTING AT NIGHT SHOOTING at night offers the chance to get very some long exposures. The classic night-time long-exposure shot that most people try is shooting trafﬁc trails winding around a road. A relatively short exposure is all you need to capture these trails, and in a town or
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city where there is a lot of ambient lighting, an exposure time of as little as 30secs may be all you need to capture a trafﬁc trail. Out in the countryside, where there is less ambient light, a far longer exposure will be needed to capture both the trafﬁc trail and the



surrounding landscape. The length of the exposure will depend on the level of ambient light. Under a full moon, an exposure of 1-2mins may be enough, but if it is a new moon and an overcast sky, the exposure may need to be as long as 1hr. Of course, this also depends on whether or not
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an ND ﬁlter is being used, and the choice of aperture. At night under a new moon, an ND ﬁlter may well be unnecessary. Another classic long-exposure subject is star trails. These images appear to show the stars moving across the sky – an effect that is actually created by the rotation of the Earth. To create a good star trail, exposure times can last from 15mins up to many hours. One key piece of advice when photographing star trails is to make sure that a large aperture is used – try to use a lens with an aperture of f/2.8 or larger. The light from stars is faint and, as they move across the frame, it is important to capture as much of the light as possible at any one time. If the landscape is to be included in an image of star trails, then the required exposure time will once again depend on the level of ambient light. Just as with trafﬁc trails, the brightness of the moon can dramatically affect the exposure time necessary for illuminating the landscape. To capture star trails, there must also be very little light and atmospheric pollution. The best star-trail images therefore tend to be taken in the countryside on cold, clear nights.
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A shimmering effect can be created where waves hit a sandy beach Canon EOS 5D Mark II, 16-35mm, 213secs at f/22, ISO 50



RICHARD SIBLEY



SHOOTING WATER From waterfalls and rivers to lakes and oceans, a long exposure can transform a simple image of water into an otherworldly experience THE CONSTANT movement



Look for interesting structures that are surrounded by water to create a focal point is particulalry frustrating, but can often be solved by standing a dry patch of sand and really pushing the tripod legs in to the ground, or by ﬁniding some rocks to set-up on. Remember to always wash the legs of the tripod after using them on the
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of water provides an obvious subject for long exposure images. With a long enough exposure water turns in to a blurred mist as the random movements of the water become exposed on the cameras ﬁlm or sensor. Even with just an exposure of a few seconds water can become blurred, but given a longer duration, water begins to look like a mist or fog, forming almost a cloud-like appearance. Combined with clloud movement long exposure images of seascapes can begin to take on the appearance of another world entirely. Whilst the water and sky can make interesting patterns and tones, long exposure images of moving water can often beneﬁt from having a stationary subject in the shot the juxtapose the surrounding movement, or act simply as the focal point of the image. Obvious subjects are rocks, jettys and groynes. One thing to remember when shooting images near water, whether it be a lake, river or the sea, is that the ground will generally be very soft. Over the course of a long exposure it may be that the camera and tripod will slowly sink in to the crowd a little. On sand this



beach as the sand and salt water can damage the locks and tubes. On other soft land make sure you give the legs a little push in to the ground and leave the tripod to settle for a short time before attempting a long exposure image.
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Improve your photography Digital photo courses for all levels Apply now Offer on Photoshop CS6 Extended



‘I started with the SPI Foundation in Photography in 2009 and learned so much from this course. I always look forward to getting feedback from my tutors and I am currently completing the Foundation in Digital Imaging Techniques course.’ Ross Mackenzie



Our exclusive deal with Adobe allows our students to purchase CS6 Extended for £190.80*



DIPLOMA IN DIGITAL PHOTOGRAPHY



FOUNDATION IN PHOTOGRAPHY



FOUNDATION IN FOUNDATION DIGITAL IMAGING IN DIGITAL PHOTOGRAPHY TECHNIQUES



●



●



●



COURS FEES ONLEY



£299



Winning composition Making landscapes with impact ● Expert metering techniques ● Shooting striking portraits ● Mastering still life ● Depth of ﬁeld control ● Controlling ﬂash ● Wildlife and nature photography ● Using colour ● Sports and action shots ● Choosing the right lens ●



COURS FEES ONLEY



£299



Size and crop a digital image ● Adjust tones, correct colours and convert your images to monochrome ● Use the selection tools to adjust certain areas of your images ● Remove dust and scratches from precious photos ● Banish redeye forever ● Sharpen your images ● Create an archive to safeguard valuable pictures



COURS FEES ONLEY



£195



● Viewpoint



and composition ● How to use your camera’s program modes ● All about lenses ● Sharpening your image ● Formatting, sizing and printing ● ISO, ﬂash, exposure and white balance setting ● Basic image editing



COURS FEES ONLEY



£299



Foundation in photography



To fast-track your photography skills call 0203 148 4326 or visit WWW.SPI-PHOTOGRAPHY-COURSES.COM



Please quote ref: SPI010



WorldMags.net



*This price is a special rate for those who do not qualify as a ‘full-time’ student in order to obtain a discounted version of CS6 Extended direct from Adobe



Working with tones: Levels and Curves ● Contrast control ● Using white balance ● Black & white techniques, toning and staining ● Working with colour ● Retouching and sharpening ● Sizing, printing and storing
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USE SHALLOW DEPTH OF FIELD



DAMIEN DEMOLDER



Opening an aperture to its widest extent achieves more than just fast shutter speeds. We explain some creative uses for a very shallow depth of ﬁeld
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THERE are a number of photographic styles for which maximising the depth of ﬁeld is a priority. For instance, most landscape photographers will try to get as much of the scene in focus as possible, using techniques such as hyperfocal focusing, while macro photographers will use small apertures or focus



stacking to ensure they get all of the subject in focus. While the technical side of this is a real skill, using a shallow depth of ﬁeld can be just as creative. Shallow depth of ﬁeld is a technique used for many purposes, but most commonly to draw the viewer’s attention to a particular point of interest by obscuring the rest of



the scene. As it is difﬁcult to achieve a shallow depth of ﬁeld when shooting a general scene with a compact camera, there is a perception among the general public that images with shallow depth of ﬁeld are the realm of the professional. This belief has been boosted by the introduction of video capture on DSLRs. Prior to this, a shallow depth of ﬁeld was difﬁcult to achieve with conventional consumer video cameras because of their small sensors. But now, even an entry-level DSLR can be used to create this effect, which is reminiscent of the movies, and manufacturers are keen to promote this cinematic aesthetic.



their ranges for under £200, and it is possible to ﬁnd used versions of these lenses for under £100. Don’t forget that many standard kit lenses supplied with ﬁlm SLRs used to be 50mm f/1.8 models, so there is an abundance of these optics available second-hand; for owners of Nikon or Pentax DSLRs, these lenses should ﬁt straight onto the camera. For other DSLR makes or compact system cameras, an adapter may be required, but even with the cost of this included, it should be possible to buy an old



SUITABLE LENSES The larger the maximum aperture, the better a lens will be for achieving shallow depth of ﬁeld in its images. Generally, a standard-focal-length lens with a maximum aperture larger than f/2.8 is necessary, with a f/1.8 or even a f/1.4 lens preferable. While this may sound expensive, there are affordable options out there. Both Nikon and Canon have 50mm f/1.8 lenses in Older manual-focus lenses are an affordable way to get a lens with a large aperture. This Nikkor 50mm f/1.4 lens was a bargain at just £80



‘There is a perception among the general public that images with shallow depth of ﬁeld are the realm of the professional’



ACHIEVING SHALLOW DEPTH OF FIELD AS WE all know, a wide aperture is required for a shallow depth of ﬁeld – the larger the aperture, the shallower effect. However, this isn’t the only consideration; the relationship between the focal length of the lens and the focus distance to the subject is just as important. For example, a DSLR with a full-frame sensor, 50mm lens and aperture of f/1.8 will create a depth of ﬁeld of just 17cm when photographing a subject 2m away. A compact camera with a 1/1.63in sensor, with its lens set to the equivalent of 50mm and f/1.8, might be expected to provide the same depth of ﬁeld. However, this is not the case, even if the angle of view remains the same as with the full-frame camera. This is because depth of ﬁeld is dictated by the actual focal length of the lens. So, using our compact camera with its 1/1.63in sensor and 10.8mm focal length (equivalent of 50mm on a full-frame camera), the f/1.8 aperture actually gives a depth of ﬁeld of 75cm. This is why it is more difﬁcult to achieve a shallow depth of ﬁeld with a compact camera. So rather than thinking about equivalent focal lengths, it is the actual focal length of the lens that is important. This advice also applies when using the APS-C or four thirds formats. Conversely, cameras with medium-format sensors, such as the Pentax 645D make it possible to create an even shallower depth of ﬁeld. In the same scenario as above, with an 85mm lens (equivalent of a 50mm on a full-frame camera), the depth of ﬁeld at f/1.8 is just 9cm. Even at a more realistic f/2.8,
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17cm focus



DSLR 50mm f/1.8



2m 75cm focus



Compact 50mm equivalent



2m



depth of ﬁeld is still shallower than the 35mm full-frame camera, at just 15cm. The closer the point of focus, the shallower the depth of ﬁeld will be. However, the depth of ﬁeld of a 300mm lens at f/2.8 focusing at 10m is the same as a 30mm f/2.8 lens focusing at 1m. Both
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produce a depth of ﬁeld of 18cm. While the angle of view might change, if the subject is the same size in the frame then the depth of ﬁeld is also the same. Lens choice is therefore a consideration when shooting images with a shallow depth of ﬁeld.



USE SHALLOW DEPTH OF FIELD
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ROUNDED APERTURE BLADES
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BOKEH AND SPECULAR HIGHLIGHTS FOR THOSE unfamiliar with the term, ‘bokeh’ describes the out-of-focus area of an image. The look is characterised by the shape of the aperture blades of a lens. Thus, a hexagonal aperture will produce hexagonal bokeh. This can be seen in out-of-focus specular highlights, which take on the shape of the blades. Ideally, a smooth bokeh is preferable, and it is rounded aperture blades that create this. One advantage of shooting with the aperture fully open is that the bokeh will always be circular,



due to the blades not obstructing the light coming through the circular lens barrel. As a result, images usually have very smoothly graduated, natural-looking bokeh. One of the best times to see specular highlights is when shooting cityscapes at night. The combination of the shallow depth of ﬁeld and these highlights lend images a very cinematic look. Out-of-focus lights become highlights devoid of detail, and they can even start to blur into one another to



create interesting patterns and shapes. Immediately following rain is another occasion when you can use shallow depth of ﬁeld to achieve that ﬁlmic effect. Wet surfaces are highly reﬂective so shoot your subject against a background that contains lots of light sources, such as street lamps, illuminated signs, trafﬁc lights and so on, to create even more highlights. You can also use a bit of ﬁll-in ﬂash to increase the separation between the subject and background.



When shooting portraits, a shallow depth of field can turn a distracting background into smooth gradients



DAMIEN DEMOLDER
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F/2



F/4



manual-focus 50mm f/1.8 lens for less than £50.



SHOOTING WIDE OPEN



RICHARD SIBLEY



F/5.6



F/16



Except for in low-light conditions, most photographers avoid shooting with a fully open aperture. This is because a lens will not be at its sharpest at this setting and will tend to produce lower-contrast images. Vignetting and chromatic aberration will also be at their most intrusive. However, shooting wide open is necessary if the photographer wants to obtain the shallowest depth of ﬁeld possible. On these occasions, most of the problems can be lived with. For instance, while sharpness will vary from lens to lens, ﬁxed optics will generally still be of an acceptable sharpness even when fully open; contrast can be adjusted in image-editing software, while vignetting is quite easily removed, or it can even be beneﬁcial by concentrating attention on the centre of an image. However, chromatic aberration will always be of some concern, especially with cheaper lenses. The effects of this type of distortion will be at their worst along high-contrast edges,
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Left: Even the slight change between f/2 and f/4 can make a big difference to the depth of field
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towards the corners of an image, so try and make sure your subject is close to the centre. Of course, this isn’t always possible, so when shooting wide open, save images as raw ﬁles so that chromatic aberration can be removed later using software. Alternatively, convert the image to black & white, where the aberrations may not be as noticeable. Another option is to stop down the lens. If you have a lens with a f/1.8 aperture, stopping down to f/2.8 may reduce chromatic aberration, while still producing a shallow depth of ﬁeld.



SHALLOW PORTRAITS One way in which the softness of a wide-open lens can be used positively is for portraits. The shallow depth of ﬁeld means that when focus is on the subject’s eyes, very often other facial features will be slightly soft. Combined with the fact that a lens is naturally softer when at its maximum aperture, it is easy to achieve a slight soft-focus effect. This is a particularly ﬂattering effect when taking female portraits, as it slightly softens and smooths the skin. But beware, shooting portraits in this Below: Use a shallow depth of field to pick out a specific subject in a crowd



USE SHALLOW DEPTH OF FIELD
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TOP TIPS



A shallow depth of field when shooting wildlife helps to isolate the subject



On bright, sunny days, use a ND ﬁlter to reduce the exposure to allow you to shoot wide open, without overexposing the image



1



Use continuous shooting and continuous AF to ﬁre a burst of images to ensure that one is in focus



2 3 4



Remember that out-of-focus areas can act as a frame for the subject



Don’t be scared of adding to the natural vignette of shooting wide open. It can help focus attention away from the edges It is possible to pick up older manual-focus 35mm or 50mm f/1.8 or f/2.8 lenses at very affordable prices



5



way can be tricky, because with a shallow depth of ﬁeld any movement either by the photographer or the subject, however minute, can cause a shift in focus from the subject’s eye to their nose or ears. Sometimes even the slightest movement can cause a noticeable shift from the pupils of the eye to the eyelashes. If you are taking portrait images
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‘Shallow depth of ﬁeld can be useful when shooting a group of items, such as a face among a crowd, or a ﬂower against foliage’ using an autofocus camera, switch to continuous shooting and continuous AF mode, and use focus tracking or keep a focus point on the subject’s eye. Rather than taking a single shot, ﬁre a burst of three images and then choose the sharpest. If using a manual-focus lens, try just shifting the focus barrel slightly as you hold down the shutter button.



ISOLATE A SUBJECT The main purpose of using a shallow depth of ﬁeld is to isolate the subject from its surroundings. It is a very simple technique for directing the eye straight to the subject of the image. This can be useful when shooting a group of items, such as a face among a crowd, or a ﬂower against a busy background of foliage.
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It can also be a good way of framing a subject. By using a wideangle lens and getting down low in a scene, both the foreground and background will be very blurred and out of focus, leaving the main subject sharp and completely framed by out-of-focus areas. Which, once again, makes the subject very obvious to the viewer. ADVANCED PHOTOGRAPHY SKILLS 41
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PAINT WITH LIGHT



Painting the subject evenly will give nice all-over lighting that shows much of the detail. By using the snoot and pointing the torch from a distance, the background and foreground can be lit to emphasise the subject



PAINT WITH LIGHT We explain how to use small LED lights and torches to create exciting hand-lit images THE FANTASTIC lighting styles adopted by many professionals don’t always require a whole studio full of expensive ﬂash heads and a range of light modiﬁers. By using a long exposure in a darkened room and a simple LED light, it is possible to sculpt



the light and achieve a speciﬁc lighting style without a complex lighting set-up. More importantly, it is an inexpensive alternative to a large studio. Everything from a spotlighting effect to low key, rim lighting and many more can be achieved, and you can also learn a lot about how
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using light at different angles can completely change the look of an image. These basic skills can also serve you well when using other lighting equipment. Simple LED lights are available in a number of forms, from very cheap single LED torches to those with slightly more power designed speciﬁcally for photographers and videographers, such as the Manfrotto ML240 Mini pictured above (£69.95 www. manfrotto.co.uk). Here we will show what is needed to get the best results when painting with light, and demonstrate various different methods and lighting techniques for you to expand upon.
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PAINT WITH LIGHT



WorldMags.net Colour and texture also play a large part in the exposure. A shiny white object will require a very short time to illuminate it, whereas a dark matt object will need a much longer exposure by comparison.



HOW TO LIGHT THE SHOT



WHAT YOU WILL NEED



MOST importantly, you will need a camera that offers manual control. You will need to be able to set the aperture, ISO, shutter speed and white balance. For more detail on the settings, see Judging exposures (below). As with most long-exposure shots, it is important to keep the camera stabilised. A tripod and cable release are the best tools for achieving this, although placing a camera on a tabletop or resting it on a secure and stable surface will sufﬁce – as will the camera’s self-timer in place of a cable release. Also make sure that the subject you are photographing is on a secure surface and does not move while the shutter is open. Speaking of which, there are many things that will make great subjects for this type of photograph. A single rose in a vase is something of a classic for light painting. Everyday items are also good for experimenting with. Old, worn items with a lot of texture often make great subjects, as do ornate pieces of glass, or statues and other ornaments. Finally, you’ll need a background and foreground. These do not need to be expensive rolls of Colorama paper, as pieces of card will also work well and are readily available from craft shops. Wood, metal and stone are other alternatives, but while their texture can create really interesting images, for some shots it can also be a distraction. Glass or Perspex placed over the top of the background will give a nice reﬂective surface, adding another dimension to the image.



The really exciting thing about painting with light is that a completely different look can be achieved with every push of the shutter button. There is no right or wrong way to light-paint a subject, but using the torch makes it easy to create a different depth, mood and feel in each shot. Often when using a standard on-camera ﬂash, the lighting doesn’t look very dynamic because it lacks shadows – on-camera ﬂash has a tendency to make images look very ﬂat. However, angling the torch at between 45° and 90° to the subject will emphasise its depth and texture. Lighting from above will have the same effect. Often the best-looking shots are low-key images where the subject only partially emerges from the darkness.



A piece of paper can be fashioned into a DIY snoot



LIGHT IT RIGHT



Think of the torch like a can of spray paint. If you hold it close to the subject in one spot for a few seconds, that area will be covered with a greater intensity. If you spray from a distance, there will be a wider spread and a softer coating on the subject. The light can be modiﬁed in a number of ways. For instance, a simple snoot made of paper (see above) will concentrate the beam and stop any light from spilling out. This can be very useful for creating a spotlight effect or when shooting precise areas, for example. Coloured gels can also be used to modify the light and achieve creative shots. A cheap and effective way to acquire these is to use sweet wrappers doubled over and held over the light source. Multiple colours can be combined to achieve some interesting lighting styles and to create mood. The traditional blue and red combination is a personal favourite.



JUDGING EXPOSURES If the room is fully dark, then the shutter speed doesn’t matter because the exposure is created entirely by the source of light. Thus, your exposure is determined by how much light you give the subject. With the camera set to f/20 and ISO 100, around 30secs is ﬁne for a subject of around 40x40cm. I use a small aperture because it allows a longer shutter speed, which gives me more time and more precise control over where the light is falling. If using the light from a distance, the intensity will be much lower so I would advise setting the camera to bulb mode. Bulb mode may also be needed for larger objects, as the bigger the object, the longer it takes to illuminate it. If the room is not completely light-sealed, then a shorter shutter speed will be necessary to reduce the amount of ambient light in the image.
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Lighting the subject from slightly above will highlight it while giving it a pronounced edge. This can appear like a glow if the light is left on for long enough. By not letting any light hit the front of the subject, only its outline and the most heavily pronounced details are picked out



Sweet wrappers make ideal ‘gels’ for small torches
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For this shot I lit the subject mainly from above and filled in from the bottom to give a good balance of shadows and highlights. I also ensured that no light hit the background so that it recorded as a true black
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PAINT WITH LIGHT



This image is shot with a paper snoot from above and to the left to give a spotlight effect. Once the subject had received enough light to make the exposure, I passed the torch over to the other side for a short amount of time to pick out some of the detail



For this shot I switched on a tungsten lamp positioned to the right of the subject. I turned the lamp off after only a couple of seconds and then painted the left side using the torch. As my white balance is set for the colour temperature of the torch, a lovely orange glow is given to the image with colour gradients from left to right. Playing with different light sources can create fantastic results
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Try not to stray into the shot, but if you have to do so then keep the torch close to your body



BEFORE



TOP TIPS



ON A LARGER SCALE… All the techniques learned by lighting smaller objects can be transferred to something larger. All you need is a bigger torch TO LIGHT an exterior building at night, the same principles apply as when lighting a ﬂower or ornament. The shutter speed must be slow enough to allow time for you to build up the light level with a powerful torch, but the exposure time must also be short enough to ensure that your subject is not illuminated by any ambient light in the scene. The ﬁrst thing you should do is take a shot of the scene to help you estimate the longest exposure that you can use. If you are lucky enough to have a moonless sky in the middle of nowhere, you may be able to use a time that extends to minutes, but on a moonlit night near an urban area your exposure
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will need to be a lot shorter. I tend to set the camera’s shutter speed to 30secs or bulb mode and use a low sensitivity setting of ISO 80-200. I also set the aperture of the lens to f/8-16 to get the longest exposure possible before diffraction starts to blur the image. Be prepared: achieving the right result can be time-consuming and rather frustrating, and it may take a little trial and error to ﬁnd what’s perfect for you. When lighting the subject, keep the torch moving otherwise you may end up with some areas that are brighter than others. As you will most likely be walking around the scene to pick out different areas, it is important to make sure that the



torch bulb is never in shot because it could result in a streak of light across the image. Another key piece of advice is to wear black. If you stand still long enough in a white T-shirt you may end up being visible in the image, but a black outﬁt will make it far less likely that your shadow will appear. Try not to stray into the shot, but if you have no choice but to do so then keep the torch close to your body with your back to the camera, and don’t stay in the same position – keep moving!
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1 Keep moving 2 Wear dark clothing 3 Use coloured lighting gels over the torch for extra impact 4 Think about your choice of subject. Derelict or abandoned buildings, cars or even shipwrecks work well 5 The Olympus OM-D cameras have a live bulb mode that updates the screen with the current exposure every few seconds. When the perfect exposure appears on-screen, close the shutter. This takes a lot of the guesswork out of creating the image
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THE PERFECT RATIO
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THE PERFECT RATIO Cropping an image to create a panorama might seem like a slightly cheap way to make a bad photograph better, but some of your shots could really beneﬁt from the panoramic treatment



ALL IMAGES: BARNEY BRITTON



MOST digital photographs are taken, printed and displayed in the native aspect ratio of the sensor on which they were taken. In the case of DSLRs, this is usually 3:2 or 4:3. Something that many photographers don’t stop to think about is the fact that, although this is how cameras are designed to view the world beyond their lenses, we humans see it as a panorama. When we’re concentrating on one particular subject, our attention is focused in a rough circle.



12:5 FORMAT



16:9 FORMAT The term ‘panorama’ was coined in the 19th century and has come to refer to any ‘wide’ view, but speciﬁcally one where the horizontal dimension of an image is considerably greater than the vertical. Cinema popularised panoramic photographic images, and the most common cinema aspect ratio is Panavision, which is roughly 7:3. The 16:9 format, which remains the most common panoramic format for still photography, was made popular by multi-format APS ﬁlm cameras.



XPAN-STYLE PANORAMIC



12:5 FORMAT



The 12:5 aspect ratio of the XPan format is great for creating wide, sweeping compositions (see above), but watch out that you don’t enlarge pictures too much – cropping to this format reduces the total resolution of an image.



XPAN (12:5 FORMAT) The Hasselblad XPan was the camera that reinvigorated highquality panoramic photography for 35mm ﬁlm users. Its unusually long, thin image format of 25x65mm is brilliant for really wide, sweeping landscapes, although the format is considerably slimmer, and more of a ‘letter box’ than 16:9. This has advantages – scenes appear wider and more dramatic – but 48 ADVANCED PHOTOGRAPHY SKILLS



disadvantages, too. If you’re printing on A4/A3 media, more of the paper will be wasted, because a greater area is cropped off at the top and bottom of the image. For the same reason, if you start with the same ﬁle, a 12:5-format image will be of a lower total resolution than a 16:9 image, which may limit your enlargement options.
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16:9 FORMAT CITYSCAPE



16:9 FORMAT



When this image was shot, it was easy to visualise it in the panoramic format immediately because its main elements are ranged in a line across the middle of the frame. This encourages the viewer to ‘read’ the picture from left to right. The brickwork and pavement at the top and bottom of the original image are superfluous, and can be removed without the picture losing anything.



16:9 FORMAT 12:5 FORMAT



16:9 FORMAT PORTRAIT



The portrait (above) works well when cropped to the 16:9 format because it helps to concentrate the composition, removing the ‘dead space’ around the edges of the key element – the subject’s face.



12:5 FORMAT STILL LIFE Although it is unusual to see vertical panoramic images, some compositions, such as this still life (right), suit the format.



AIRLINER STUDY The 12:5 aspect ratio is great for scenes like the one below, with lots of dead space at the top and bottom of the frame. Cropping this image to 12:5 concentrates the composition on the airliner.



MAKING A MASK Although digital technology does make cropping images easier post-capture, when visualising which format suits a particular scene best, you can’t beat a bit of old-fashioned DIY with a sharp knife and some cardboard. Now that most cameras feature live view, it is possible to set up a shot using the rear LCD screen. Here, I’ll show you how to make a simple mask, to preview the effects of cropping to a 16:9 aspect ratio.



1



Measure the display area of your camera’s LCD screen. Remember that when an image is displayed in live view mode, it may be slightly smaller than the total screen area, so measure from the live view image, not from the edges of the screen itself. The image will either be in the 3:2 or 4:3 aspect ratio. Here, my Nikon D300’s LCD image measures 62x47mm. The vertical dimension is the y axis, and the horizontal is the x axis, so y=47, and x=62.



2



To calculate the y dimension of the image area when cropped to 16:9, you need to perform the following calculation: (x/16) x 9. This gives me a ﬁgure of 34.8, which I will round up to 35. Now I know that a 16:9 format crop on my camera’s LCD screen measures 62x35mm.



3



Take a piece of cardboard, and measure out a 62x35mm ‘letter box’ on it, then cut out this aperture using a craft knife. Trim the border, and you have your very own custom-made panoramic mask that you can place over the live view image of your camera to preview the effect of cropping to the 16:9 format post-capture. You can also hold it up to your eye to see how a scene looks. It might seem silly, but it works – try it!
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STREET PHOTOGRAPHY
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STREET PHOTOGRAPHY Some of the most memorable photographs from the 20th century fall into the street photography category. We explain how to try it for yourself
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STREET PHOTOGRAPHY



WorldMags.net STREET photography is the term used to loosely describe a type of documentary photography that involves taking pictures of everyday life in our towns, villages, streets and lanes. It often makes the ordinary seem extraordinary and provides a commentary on the world around us. It is personal to the photographer and the subjects, and is often ‘of the moment’. At its best it can reveal the humour, pathos, routine or even heroics that make up our daily existence. Although many people, including non-photographers, recognise and appreciate the work of some of the great street photographers like Cartier-Bresson and Robert Frank, we live in paranoid times and some are suspicious of people taking photographs. Not everybody appreciates being photographed, so it pays to be careful, make sure you only shoot where you are allowed to and, if possible, adopted a casual, relaxed manner. That isn’t always easy when you half expect a Police Community Support Ofﬁcer to tap on your shoulder at any moment, but I hope the advice in this article will help and encourage you to give it a go.



from our bag or pocket, but some events are so ﬂeeting that you need to have the camera in your hand, set up and ready to ﬁre. The key is to go out expecting to see something to photograph and actively look for it, so when it happens you are prepared. The improved battery life of most modern digital cameras means that you can keep your camera switched on for the majority of your expedition without worrying that it will run out of power by the end of the day.



EXPOSURE



BE PREPARED Most of us have walked down a street, perhaps on the way to the ofﬁce or the pub, and been struck by the thought that a particular scene would make a good photograph. If we are lucky there is enough time to retrieve a camera



The girl’s expression drew me to take this shot



When you ﬁrst step out onto the street, check that your camera is set to a suitable sensitivity setting, or is loaded with suitable ﬁlm. A setting of ISO 400 is often a good choice as it is slow enough to keep noise (or grain) levels down, but also provides plenty of scope for fast shutter speeds and moderate apertures. As nightfall and/ or winter approaches, you may need to push the sensitivity setting higher. A shutter speed of 1/200sec is sufﬁcient to freeze most walking subjects and camera shake (depending upon the focal length of the lens in use), but you might want to consider something a little slower if you plan to introduce some blur. An aperture of f/8 is a good starting point that provides reasonable depth of ﬁeld, but doesn’t restrict shutter speed too much. However, a larger aperture of f/2.8 or greater gives much more



ALL IMAGES: ANGELA NICHOLSON



I used the Sigma DP1’s distance scale to set the focus manually to allow me to capture these women gossiping on the tube
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separation between your subject and its background.



FOCUSING Many modern cameras have an automatic AF-point selection mode that usually targets the nearest subject and focuses on it. If you’re lucky it will select the subject you have in mind, but it takes control away from the photographer and it is often better to determine the AF point yourself. With stationary subjects there may be enough time to toggle around the screen to activate the correct AF point, but when you need to be quick it is better to pre-select the central AF point and use the ‘half-press to focus then recompose’ technique. The central AF point usually has the advantage of being more sensitive than the surrounding points. If you have a camera that features a touchscreen, the quickest way of changing the focus point is usually to simply touch the subject on screen. Another approach is to use the time-honoured street photographer’s technique of selecting an aperture of f/11 or smaller, setting the camera to manual focus and pre-focusing the lens to the hyperfocal distance or the distance at which you wish to



‘Shooting mono images is a good way of dealing with distracting colours’ photograph your subject (perhaps 2m or 3m). This may not have the absolute accuracy of focusing precisely upon the point of interest, but the depth of ﬁeld should ensure it is acceptably sharp and it frees you up to concentrate on the composition.



SUBJECTS Although many street photographs include people, they don’t have to. A shot of a car parked in the only yellow-lined section of an otherwise empty street, for example, raises questions about the driver’s state of mind or what the street might have looked like a few hours ago. While you can shoot random images sporadically, it can be helpful to have a project in mind. It might be to document life in the cul-de-sac where you live, or a childhood haunt. Having a project can be a useful introduction to potential subjects or



to anyone asking what you are doing. Inanimate objects are a good place to start with street photography, and after getting a few shots you should start to feel more conﬁdent and ready to tackle people pictures. Places with a happy, friendly atmosphere, like a farmer’s market or a music festival, can be a good introduction to street photography that includes people. Many subjects will happily pose and won’t be too upset about being caught unawares. Some shots of people need to be taken before they realise what you are doing so you capture the moment, but don’t be afraid to ask someone if they mind you photographing them. With a market stall holder, for example, you might want to start with a fairly straight portrait shot, but then ask them to carry on with their work. After a while you will both start to relax and you can get some natural shots of their interaction with the customers.



MONOCHROME OR COLOUR While we most commonly associate street photography with black & white images, Martin Parr’s work demonstrates that colour shots can work just as well. Many



LENSES Lens focal length is an important consideration. Optics with short effective focal lengths, such as 24mm or 28mm, are useful for capturing the wider view and have greater depth of ﬁeld than longer lenses. However, wideangle lenses can often mean being very close to your subject, which will almost certainly alert them to your presence and change their behaviour. Telephoto optics are a good choice if you want to tightly frame distant subjects. They are a good choice for a nervous street photographer. Don’t forget the standard 50mm lens as these optics usually have a large maximum aperture, which is great for low light or minimising depth of ﬁeld. They also produce images that are similar to what we see naturally with our eyes.



I converted this image to monochrome to remove distracting colours from the background



Taken during a break at a local ploughing match 52 ADVANCED PHOTOGRAPHY SKILLS



digital photographers have the luxury of being able to shoot both monochrome and colour images by shooting simultaneous raw and JPEG ﬁles (with the camera set to black & white). Shooting (or converting to) monochrome images is a good way of dealing with distracting colours, helping the message of a picture to be conveyed more clearly.
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TRAVEL PHOTOGRAPHY



From what to pack in your camera bag, to making sure you are in the right place to take photos, our essential guide to travel photography will help to make sure that you come home with fantastic memories of your holiday destination
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TOP TIPS TO HELP YOU BEFORE YOU GO DO YOUR LOCATION RESEARCH



Once you’ve decided where you are going, do some more research on the location. To start with, consider the main landmarks, the most popular locations that are shot by photographers. Any good guidebook should be littered with pictures of these places, but it’s also worth looking on websites like Flickr or Google images. Once you have the main locations look for other subjects that may deﬁne the place, whether it’s the people, a local festival, market stalls or beaches.



WHAT DO YOU WANT TO ACHIEVE?



Make sure your expectations are realistic – if you’re on a family holiday you may not want to spend all your time chasing the perfect light. From your research, make a list of the places or types of shots you want to take, so you have something to refer to once you’re there. Consider setting yourself a theme.



CHARGE YOUR BATTERIES



Your camera will be no use to you if the battery is dead. Make sure you charge all your batteries before you go, and have spares if possible – including AAs for ﬂash. Pack your chargers too, as extreme temperatures (and a heavy trigger ﬁnger) can drain batteries quickly.



GET SOME PRACTICE IN



Unless your chosen location is nearby, this could be your one chance to get shots there. So make sure you’ve honed your camera skills for the type of shots you’re after. Take a few trips out in your local area to practise. The scenery may not be identical but your technique won’t change that much. If you’re planning a safari, head down to your local zoo – it will give you an idea on focal lengths.
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TRAVEL PHOTOGRAPHY
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WorldMags.net It pays to stay up late or get up early to get shots that you usually wouldn’t get if merely thinking like a tourist



BASIC CHECKLIST



WHAT TO PACK



There’s plenty to think about before you even begin your travels once again depends on the subject matter. A DSLR is a good all-round option, but if you are going to spend time travelling from one location to another, a compact system camera, or even a high-end compact can be just as good. The advantages of a compact system camera are obvious: the cameras are smaller and lighter and are much more comfortable to carry around on your shoulder all day. The lenses are also often smaller and lighter, particularly if using a micro four thirds system camera, so it is possible to ﬁt a camera and a few lenses in a



small shoulder bag, or even a large coat pocket. High-end compact with APS-C sensors make great cameras for travel photography. Although they have ﬁxed lenses, they usually have a 28mm or 35mm lens with a large aperture, making them good for landscapes, cityscapes



AIRLINE RESTRICTIONS While British Airways has a maximum size for hand luggage of 56x45x25cm, each airline is free to set their own guidelines on size and weight. British Airways also states that you must be able to lift the bag, unaided, into the overhead hold, while Virgin Atlantic requires a maximum of 56x36x23cm and a weight of 10kg (for economy and premium economy). Ryanair limits this to 55x40x20cm and 10kg, plus one small bag measuring 35x20x20cm. For more information, check the website of the company you are flying with.



45cm



AS YOU will often spend hours with the camera round your neck and a bag on your shoulder, you don’t want to take everything that you own with you. Good research can really help you to decide the essentials; for example, if you are going to Iceland then a wideangle lens is a must for landscape shots, while a short telephoto lens will help you shoot street photography images in Havana, Cuba. However, there are bound to be times when you wish you could get a little bit closer or your lens was a little bit wider – the key is to minimise those times. As for what camera to take, it



56cm



Even simple things are worth documenting. Look out for humorous signs or translations 56 ADVANCED PHOTOGRAPHY SKILLS



■ Travel tripod (or other support) ■ Battery charger and batteries ■ Polariser ■ ND ﬁlter ■ ND graduated ﬁlter ■ Filter holder (if needed) ■ Camera strap ■ Plug adapter ■ Lens cloth ■ Lens hood ■ Remote release ■ Memory cards
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HOW TO PACK SMART



CHECK YOUR EQUIPMENT It may seem a little obsessive but try all your lenses, ﬂ ashguns and cameras before you go, to double check they’re all in working order. A quick test shot with each should do the trick and if the alternative is being stood on the beach for the perfect sunset with a broken lens, it’s half an hour worth spending. Dust spots are annoying on any picture but if you have to clone the same ones off hundreds of holiday shots you’ll be cursing. Take a few test shots of a white wall or blue sky and check your images for dust. Take a lens cloth to both the front and back elements of your lenses to make sure they’re clean. If there’s dirt on your sensor try using a light air blower (not canned air) to remove it and, if necessary, use a sensor swab or dedicated sensor cleaner.



When you travel anywhere with your camera gear, you should always make sure your bag is packed as well as possible. This is especially true with air travel. Hand luggage restrictions can be especially challenging for the photographer, especially for the DSLR user, in terms of size and weight. Keep your memory cards safe and in one place with a separate card wallet



First, pick your bag. Make sure it ﬁts your shooting needs and also that it is within the hand luggage size allowances (see page 56). Next, empty the bag completely – this way you can ensure you’re not carrying anything you don’t need,



Make sure your equipment is well protected by using the padded dividers



Don’t forget to look for everyday scenes that document life in a particular place and documentary scenes, and the aperture means that low-light shots are also an option. However, the downside is that you are, of course, restricted to just a single lens. On balance, a good compact system camera is probably the best option, with two or three ﬁxed lenses that will generally be smaller, lighter and produce sharper images than a zoom lens. However, a superzoom lens, such as an 18-200mm or 18-300mm, for an APS-C camera sensor provides a very versatile all-



round lens that you will rarely have to take off of your camera. Combining a superzoom lens with a secondary lens, such as a 28mm f/2.8 , 35mm f/2.8 or 50mm f/1.8, provides you with a good all-round lens and a secondary lens for more specialist tasks. For example, if you know that you will be shooting a lot of landscapes, then pack a 28mm lens, or for street portraits a 50mm optic is a good option for mid-length shots. Alternativeley, take a good



compact camera with a large maximum aperture, for example the Sony Cyber-shot DSC-RX100 II. This is small enough to keep in your pocket at all times, especially when you don’t want to take your DSLR or CSC with you. The Panasonic Lumix DMC-GM1 is another good option, as it is a micro four thirds camera which is small and compact, particularly when used with a pancake lens. Plus, it offers the ﬂexibility of being able to use other lenses.
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or anything you shouldn’t take on a plane. Lay out all the kit you plan to take, including chargers, batteries and accessories. Now take all leads, power supplies and chargers, and pack them in your suitcase. Pack all your lenses and accessories, plus your camera, into your camera bag, using the padded dividers to ensure everything is well protected. Photographers have been known to go to all extremes to sidestep weight restrictions, from taking out the camera and putting it around their neck, to stufﬁng pockets with lenses. However, if you keep to a sensibly sized bag, you should be ﬁne. Store all of your leads and cables in your suitcase to free up room in your hand luggage
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10 TRAVEL TIPS



So you’re off! To ensure you return with cracking shots, take note of these tips



2 RESEARCH



1 HEAD FOR THE HIGH GROUND No photo reportage of a place would be complete without at least a couple of good vistas, and the best place from which to shoot these is a high viewpoint. Every city has a tall building or a



high hill from which you can get a good shot of the surrounding skyline. In addition to the obvious wide shot, try zooming in on interesting details. Try to include some foreground interest,



such as a person, building or overhanging tree, to avoid everything being at inﬁnity. You may ﬁnd a UV ﬁlter useful for cutting through the haze you often get at high viewpoints.



If you’re planning an overseas photography trip, it pays to do as much research as possible before you go. The web is a good place to start. Look at other people’s pictures of the same place on websites such as PBase and Flickr (Flickr will probably have at least one group dedicated to your destination). Visit tourist information websites for the country or city too. Mapping sites such as Google Earth or Google Maps will enable you to work out where key locations are in relation to each other and see which direction they face, so you can plan what time of the day to visit them for the best shots.



3 TAKE A TOUR When you ﬁrst get to your location visit the tourist information ofﬁce for maps and guides to help plan your time. Consider an open-top bus tour on day one, to give you a brief orientation of the place, and make notes of different points of interest along the way.



4 EYE FOR DETAIL Don’t be so focused on the big picture that you miss out on the small details that say so much about a culture. Whether it be an intricately carved doorknob or a trinket on a market stall, get right in close and exclude all extraneous information. A macro or closefocusing lens is ideal for this. Stop the lens down for maximum depth of ﬁeld or shoot wide open for an evocative shallow-focus effect. 58 ADVANCED PHOTOGRAPHY SKILLS
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7 CAMERA CARE



5 LATE IN THE DAY Some of the most interesting and colourful pictures will present themselves late in the day. Sunset is a great time for skyline shots, or head to the waterfront to capture reﬂections of that golden glow. Try shooting into the light for



rim-lit or silhouetted foreground details. Once dusk arrives and the street lights go on, your photo opportunities will increase – whether it be ﬂoodlit buildings, the ambience of a night market or perhaps the neon lights of Vegas.



If you’re shooting static subjects, a tripod will enable you to shoot at a low ISO and a long shutter speed for maximum sharpness and low noise. For candid shots in bustling places, you’ll need to shoot handheld and set a higher ISO.



Bear in mind the conditions for where you’re going and protect your camera gear accordingly. If you’re going somewhere very cold, remember to keep spare batteries warm (in your pocket, perhaps) so you can keep shooting. In sandy conditions such as deserts or beaches, or wet conditions such as rainforests, keep the camera protected from the environment. You can buy dedicated housings, which can be expensive, or you can make your own from some plastic bags and elastic bands. If you’re somewhere hot and humid, remember that the camera may fog up when going from inside to outside, so allow it time to de-mist before shooting.



6 BETTER BUILDINGS Architecture is an essential element to most foreign trips, but buildings can be hard to photograph. To increase your odds, ﬁnd out which way they face so you know when to get there for the best light. Avoid crowds of tourists spoiling your shots by shooting early in the morning, where possible. With taller buildings try to avoid tilting the camera upwards, to avoid the sides of the building converging. Shoot from further back and zoom in (or use a longer lens) or ﬁnd a high viewpoint adjacent to the building you wish to photograph.



8 KEEP IT VARIED Lesser photographers come back from their travels with a collection of views, all shot at inﬁnity. To create a really interesting set of shots it’s important to introduce variety. Add some foreground interest to as many shots as possible. Use a mixture of lenses (from wideangle to telephoto) and viewpoints to get a range of perspectives and crops and don’t forget to try turning the camera on its side to see how a scene looks in the portrait orientation. Try pointing your camera upwards, or downwards, or get down low to the ground for a dog’s-eye view.



9 BE AWARE OF LOCAL LAWS In some countries it’s illegal to photograph bridges, or railway stations. Many places prohibit photography inside churches, mosques or museums. If you don’t want to ﬁnd yourself on the wrong end of the law, check this ﬁrst. If in doubt, look for signs posted up at the location, or ask someone local, such as a policeman.
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10 MAKE NOTES When you get back home you’ll want to edit and caption your photos, and this will be a lot easier if you make notes while shooting. It may also be useful to keep the tourist maps and guides that you carried around with you. Scrawl notes in the margins to jog your memory later. Some of the newer compacts and DSLRs enable the capture of GPS information, usually via an add-on accessory, which will make captioning your photos easier. ADVANCED PHOTOGRAPHY SKILLS 59
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Try making your own A5 photo book as a memento of a holiday or other special occasion



WHAT YOU WILL NEED • Pencil • White pen • Metal ruler • Craft knife • Scissors • Clamps • Hessian • Needle • Strong thread • PVA glue



• Roller • Card • Fabric for cover • 12x doublesided A4 printer paper • Printer • Cutting mat



MAKE YOUR OWN PHOTO BOOK Rather than getting a company to make a photo book for you, why not try making your own? It’s not as hard as you might think. We explain how it’s done ALTHOUGH there are lots of companies that allow you to upload your images and print your own photo book, it is possible to make and print a book yourself. You can control the size, the paper you use and how you want the cover to look. A handmade photo book can be a nice memento of an event and make 60 ADVANCED PHOTOGRAPHY SKILLS



a great personalised gift. You might think that making a professional-looking book would be impossible without certain tools and skills, but the basic premise is straightforward, although it may take a few attempts to get exactly what you want. With this in mind, it is always best to make a few test books.



PRINTING YOUR PAGES In this example, we have kept the process as simple as possible to show how easy it is to produce your own photo book. We have chosen A5 as the size. This is a sheet of A4 paper folded in half, so it means that an A4 printer can be used. Of course, if you have access to an A3 printer you could make an A4 book, or even a book that measures 20x20cm square. However, an A5 book is the perfect size for a gift, perhaps full of holiday photos or even a small wedding album.
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One thing to remember is that you will need to use double-sided A4 paper, so make sure you put the paper in the correct way round when you are printing on the reverse. It is a good idea to do a dummy test run of the printing process, printing page numbers rather than images, so you can see which way round the paper needs to be loaded and how your book will appear once it is completed. See Page ordering (opposite) for a guide to how each of the pages and sections work together.
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DIY PHOTO BOOK



PAGE ORDERING ENSURING that your pages are in the right order and printed on the correct side of the page is probably the most important part of the book-making process. Printing a page in the wrong order may not only cause you to reprint that page, but possibly even the entire book, which could prove very costly. The book we are making here will consist of three sections, each with three A4 pages that, when folded, will produce 30 printable sides.



In publishing software such as Adobe InDesign, there are options that can automatically organise the pages for you. However, if you don’t have this kind of software you will need to do it yourself. For this guide I used Microsoft PowerPoint, as it provides an easy way to drop in images and see the layout of your entire book. Adobe Photoshop works just as well by creating an A4-sized image to act as a twopage spread in the book. Before



Inner pages



using Photoshop, or any other image-editing software, make sure that you have a plan of where all your pages will appear. This will help when it comes to printing and binding your book. To create the layout for an A5 portrait-orientation book, set up each PowerPoint slide or Photoshop image to A4 landscape and create a vertical guideline at 14.85cm. This will deﬁne the boundaries of the A5 pages within the book.



Start by ordering the inside pages, as shown in the diagram below. Work from the top to the bottom of section 1, then move onto sections 2 and 3. You will see that the sides have been left blank – these will either be stuck to the covers or will form the inside covers. Leave a 5mm bleed around all your images and text, as the book-block will be cut later. Next, order your outer pages, which will be printed on the reverse of the inner pages.



Outer pages, to be printed on the reverse of the inner pages



BLANK INSIDE COVER



6



9



18



21



BLANK INSIDE COVER



7



BLANK STICK TO COVER



19



8



BLANK STICK TO COVER



20



BLANK



4



11



16



23



28



5



BLANK



17



10



29



22



1



2



13



14



25



26



3



TITLE PAGE



15



12



27



24



Section 1



Section 2



Section 3



Section 1



the ﬁrst entry hole and then back out. As you come out of the exit hole after making the ﬁrst stitch, take the needle and pass it under the thread from the section below, making a loop that, when tightened, will pull the sections together. When you reach the end of section 2, before passing through the entry hole in section 1, tie a knot with the length of thread that remains from the beginning of section 3. Continue to thread through the ﬁrst entry and exit holes of section 1, then, as you exit, guide the needle under the threads connecting sections 2 and 3, before continuing to the next entry point. This will secure section 1 to the other two sections. Continue along the spine until you reach the last exit hole. When you do so, guide the needle under the thread below to create a loop, then tie a knot to secure the thread. Cut off any remaining thread.



Section 3



1 2 3



STITCHING THE PAGES ALTHOUGH this stitching diagram may seem complicated, the process is relatively straightforward. However, it is worth practising on some inexpensive plain A4 copier paper to make sure you get it right. The basic idea is to stitch each section in turn, then sew through the loops created in the previous section to stitch them all together. Start with section 3, pushing the needle through the ﬁrst hole from the outside and then threading it through the holes you have already created (this is covered in the step-by-step guide on pages 62-63). Continue along the spine of the section remembering to pull the entire length of thread through, leaving around 4-5cm at the end. Remember to always pull the thread along the spine to tighten – never do this at an angle otherwise you could rip the book or enlarge the holes. When you reach the end, pick up section 2, making sure it is the correct way up, and guide the needle through



Section 2



End with a knot
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Knot



Start
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STEP-BY-STEP GUIDE TO ASSEMBLING YOUR PHOTO BOOK



Use the inside of the paper box to fold your pages. By pushing the paper up against the side, it will ensure that the fold ﬁnds the middle of the pages. This is particularly important when images appear on both sides of your page, or if your images are full bleed.



1



Once folded, ensure that all pages have been folded in the correct way and that images and text appear in the right order. Any mistakes missed now will be very time-consuming to ﬁx later.



2



Now, using the paper box, you need to create a template that can be used as a guide when piercing the paper for sewing. The template should be the height of the book-block – in this case 21cm. A 5cm space has been left at the top and bottom with 3x3cm spacing for the thread. Cut a small V at each measurement.



Continue the process with section 1. Remember that this time you’ll be threading the needle through the loops already connecting sections 2 and 3. At the end of the sewing, tie a knot with the remaining thread and the 4cm piece left dangling, as described in Step 5.



7



Now you must create a spine that will cover the sewing. Measure the depth of the book-block and cut out a spine from the template you created earlier. The markings will not be seen.



8



9



13



Use the roller to apply a layer of glue to the folds of the fabric. Wait for the glue to become tacky and then start to fold the edges inwards, followed by the top and bottom. Use a clean piece of card to help you ensure that the fabric is tight against the edges of the board, and that no air bubbles become trapped. Allow to dry.



14



15



Roll the board with PVA glue and allow to dry for a moment until tacky, then place onto the fabric. Allow to dry for a few minutes, then cut the corners of your piece of fabric. Make sure that the line of your cut is around 2mm away from the corners of your covers. If it is cut too close, you will be unable to crimp the fabric and the corners of the board will show.
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3



Use a roller to apply a very thin, even layer of PVA glue to the book-block. It is very important that it is applied sparingly, as any excess will result in glue seeping between the pages in the three sections.



As discussed earlier, you should have a bleed of 5mm. From the top of the book-block, measure down around 5.5mm and draw a line. Always start from the top, as this is where you butted the edges earlier. With a ﬁrm grip on the ruler, bit by bit cut through the block. Use a new blade for every edge, but don’t apply too much pressure as this could bend the blade. For the bottom, measure down from the new straight edge at the top.
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DIY PHOTO BOOK



Once you’ve printed your pictures, it’s time to assemble all the elements of your book. We explain how to fold, trim, stitch and glue the pages of your photo book together



Butt up each section of the book in turn, from the top, to ensure your images look even from top to bottom throughout your book. Clamp your template to the middle of the section and, with it slightly overhanging your table, pierce a hole through every page where you have cut the V from the template. Repeat for each section.



4



Cut a piece of thread that is 3.5x the height of the book-block. Starting with section 3, use your needle to pull the tread through each hole, leaving around 4cm at the end. To tighten the thread, always pull along the spine – never downwards, as this could make the holes bigger or tear the pages. For more details about stitching the sections, and a diagram, see page 61.



5



6



Cut a piece of hessian (or something similar) that is the height of the book-block and about 4cm wide. Use the roller to apply a small amount of PVA glue so that it feels tacky. Place the spine onto the book-block and then surround with the hessian, ensuring it has a tight, smooth ﬁnish. This will help to keep the spine in place as it dries.



10



Using the remaining board from the printer box, measure the front and back covers, the height of which will be the same as the book-block at this stage. The cover width should be 5mm less than the book-block’s width (you will see why later). For this A5 example, the front and back covers measure 21x14.3cm. The width of the spine should equate to the depth of the book-block plus the thickness of the covers.
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Place the pieces of board onto the reverse of your chosen piece of fabric. There should be a gap of 5mm either side of the spine. Once laid out, measure the folds of the fabric. For ease, I used the width of the ruler around all four sides. Cut this out, if possible, using the ruler and knife to ensure it is straight.



16



Line up the book-block on the cover and stick it down. It should overhang the gap made earlier between the covers and the spine by about 5mm. Ensure that the spine folds around the back of the book-block before ﬁrmly pushing down and allowing to dry for a few minutes.



17



Repeat steps 16 and 17 for the rear cover and then place under a weight, ideally overnight in a warm, dry place. Remember not to apply any glue on the spine.



Place a piece of paper between the ﬁrst page and the rest of the block. Use the roller to apply the PVA glue and, as before, be careful not to apply too much. You want the paper to feel tacky, not damp.



Ensure that section 2 is the correct way up and place it alongside section 3. After guiding the thread through the ﬁrst sewing holes in section 2, as the needle appears sew under the thread from section 3 to create a loop, then continue back into section 2. This will connect the two sections together. Remember to tighten along the spine.



12
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IDEAS TO INSPIRE YOUR PHOTOGRAPHY



20



Sometimes we need a new challenge, or some fresh ideas, otherwise we risk becoming stuck in a photographic rut. So we’ve compiled 20 ways in which you can to motivate yourself to get out and take more pictures TURN the camera on, set the sensitivity to ISO 400, ﬂick to aperture priority and set the aperture to f/8. Make sure AF is on centre point, white balance on AWB and metering on evaluative. Visit the same location you’ve been to a hundred times previously, and take the same types of images. And repeat… We’ve all done it. It is all too easy to get comfortable with your camera, and your photography routine, and settle for what you know. However,



it can take so much of the joy out of photography. Part of the challenge should be learning new things, taking new photographs and capturing the perfect moment. And you don’t have to buy lots of new kit, travel the world or set yourself big projects. We have compiled a list of 20 ideas that you can use to motivate yourself and try something different. Not all of them are bold or dramatic. In fact, most are very simple, such as taking the time to make more prints, or shooting



with a different camera or lens. Others include starting a new project, such as taking a photo every day for a year, or asking a stranger if you can take their photograph. Even just spending time talking to others about photography can be inspiring. So why not pick a few ideas that you like and give them a try? They may open your eyes to a new technique, or be the start of a new project. In fact, why not set yourself the task of trying all 20 ideas on the list?



SHOOT BLACK & WHITE



One of the easiest ways to transform how you shoot is to try your hand at black & white



1
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photograph that would look great in colour – just shoot raw and JPEG images together, and you will have the best of both worlds. The JPEG ﬁles will be saved as black & white



images, while the raw ﬁles will be saved in full colour – it’s like shooting with a roll of colour ﬁlm and black & white ﬁlm at the same time. So the next time you are out, set
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THERE are many images that look far better in black & white than they do in colour, as the colour can distract from the subject. Removing the colour allows us to view the scene in a simple arrangement of shapes and tones. Where a scene lacks light and contrast, this will become even more apparent in a monochrome photograph, and as such you will begin to look at the world in a different way. Digital photography allows us to view a scene in black & white instantly, which may reveal photo opportunities that would previously have gone unnoticed. We can even increase contrast, or add a traditional coloured-ﬁlter effect, in-camera while out photographing. And we need no longer fear that shooting in black & white will make us miss a



your camera to raw+JPEG and shoot in black & white. Learning to see how light and contrast interact with the environment can only improve your photography.
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SEE AN EXHIBITION



There’s endless inspiration to be found in the work of other photographers EVEN the most proliﬁc and talented photographers sometimes ﬁnd themselves stuck for inspiration, and ﬁghting against that frustrating creative block. Always remember, though, that photography is a rich and varied art form, which is why it is entrenched in some of the UK’s most important galleries. Visiting exhibitions and seeing the work of photographers old and new is one of the most inspiring things about photography. Knowledge and inspiration are almost always gleaned from the work of fellow practitioners, so when you’re struggling for ideas, take a trip to your nearest gallery. Ever more galleries dedicated to photography are appearing throughout the UK, and typically show work that is relevant and exciting. And it’s not just established photographers who are exhibiting. Many amateurs are renting space to show their work, which is a thought worth keeping in mind. Online exhibitions are proliferating too, so you can view work from the comfort of your own home.



2



JOIN A CAMERA CLUB



What better way to meet fellow photographers, enter competitions and receive valuable feedback, all under one roof, than to join a camera club? HERE are ﬁve great reasons



31



why every photographer should join a camera club or photographic society:



Talk with like-minded photographers



Meet people who are just as passionate about photography as you are. No one will tell you to ‘hurry up’ or change the subject!
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Competitions, contests and critiques



Most clubs and societies hold competitions on a regular basis. These are often based around a theme, so members can test their skills and get advice and feedback from other members or even specially invited guest judges.



Organised pro talks Many camera



3



clubs organise for professional photographers to come and speak to the club members about photography, techniques and their own experiences.



Trips and photo excursions Some



4 5



clubs embark on day trips or holidays at discounted rates for great photo opportunities.



Library of books, and knowledge



Many clubs have shared libraries of books you can borrow, not to mention the diverse amount of experience and knowledge you’ll be able to tap into from fellow members. Find your local camera club by searching the internet or your local newspaper.



TRY A NEW CAMERA



Whether you swap with a friend or hire one, trying a new piece of kit is a great way to reinvigorate your photography WE ALWAYS



4



advocate knowing your camera inside and out. This ensures you achieve the exposure and effect you want, with few shocks. However, we can also beneﬁt from handling new kit every now and then, whether that’s trying a ﬁlm camera and seeing how differently you shoot when you have to consider the number of times you press the shutter release, or using a prime and ‘zooming’ with your feet rather than your camera. There are a few different ways you could give this project a go. If you’re a part of a camera club,
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why not suggest you all swap kit for a week and give each other feedback on what you do and don’t like about the cameras. Or swap your kit with friends. Alternatively, try companies like HireACamera.com, which caters for personal, professional and business needs, stocks hundreds of products, including compacts, CSCs, DSLRs, rangeﬁnders and accessories. Guy Thatcher, managing director, says, ‘Don’t get bafﬂed by speciﬁcations. Select the camera or lens with the features you want to experiment with or call us and we’ll suggest the right kit for you to try!’
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REWORK AN OLD PHOTO



Having trouble creating something new? Then look for an old image that could beneﬁt from your accumulated experience and beefed-up software IT’S EASY to ﬁnd yourself stuck in a rut creatively, and sometimes going back and reinvigorating an old project can be just what you need to get excited about your photography again. Dig through your hard drive and see what you can ﬁnd. Chances are you aren’t the same photographer now that you were ﬁve years ago, or even one year ago. Use the time elapsed as license to experiment – you probably aren’t as attached to the image as you were when you ﬁrst took it, so saturate, sharpen, rack up the contrast. Pull it to pieces if you want. You have no reason not to be extreme with your experimentation.



5



© JAN DE BRAUW



This is another reason to always shoot raw, and to keep the ﬁles well organised on hard drives. You never know when you might get the urge to tinker with an old project, and it’ll be a good deal easier if you have raw ﬁles. Also bear in mind that software is continually improving, 66 ADVANCED PHOTOGRAPHY SKILLS
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especially with regard to facilities like noise reduction. It’s very likely that a photograph you struggled to edit with Photoshop CS2 on a PC running Windows 2000 will prove more malleable with your latest upgrades. Load something up and ﬁnd out.
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SHOOT FROM DAWN TILL DUSK



Dedicate an entire day to taking photographs. Challenge yourself to take as many different photos as you can and really explore a location IF YOU haven’t got the patience to set yourself a year-long project, scale it back and make a day of it instead. Start taking photographs at dawn and don’t stop until dusk. There’s nothing quite like waking up at 4am, driving on deserted roads to a new location and ﬁnding the perfect spot to catch the rising sun. Once that is done, you can always have a nap in the car before taking a stroll around the area and seeing what else you can ﬁnd. Have a location in mind for the end of the day, and head there to catch the sunset – it could be a location you have researched, or somewhere you have discovered during the day that you can return to. Depending on the time of year, this could mean spending as many as 17 hours out taking photographs, resulting in perhaps hundreds of new images.



6



RESEARCH AND PLANNING



Photographer’s Ephemeris (photoephemeris.com). This is an app for Android (£3.10) or iOS (£5.99) smartphones or tablets, and is available for free on Windows or Mac computers. The sophisticated software shows a map overlaid with the exact direction of sunrise and sunset in that area, along with the time at which they will occur. Furthermore, you can check the exact position of the sun or moon for any time of the day or night. This enables photographers to scout a landscape from the comfort of their home, so without having to go to a location you can discover at what time the sun will appear from behind a hill to light the valley on the other side, or what time it will be perfectly behind the peak of a mountain to create an amazing silhouette. There is a lot of information that can be garnered from the software, and it will allow you to see exactly where you should be standing and when, which takes a lot of the luck and guesswork out of planning your day.



‘There’s nothing quite like waking up at 4am, driving to a new location and ﬁnding the perfect spot to catch the rising sun’ Look for interesting subjects in the scene



WHAT TO SHOOT? What you decide to shoot will obviously depend on your chosen location. Landscapes are the most obvious subject, but the aim of the day is to try to come away with as much variety



A Google image search will provide lots of possible photo locations for your area 68 ADVANCED PHOTOGRAPHY SKILLS
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WHAT TO TAKE As you are going to be out shooting for so long, and will probably have an early start, it is best to prepare © RICHARD SIBLEY



The ﬁrst thing you need to do is work out exactly where you want to go. While it is possible to head out with no particular location in mind and strike it lucky by stumbling across somewhere amazing, it is far better to plan ahead and decided on a location to explore. The internet makes locationscouting extremely easy. If you know roughly which part of the world you wish to visit, simply run a Google image search to ﬁnd possible locations in that area. Flickr is also an excellent research tool: just search for a location and see what other people have photographed there. You can even reﬁne your search by adding the words ‘sunrise’ or ‘sunset’, for example, to see images taken at those particular times of day. Of course, these images should only be used for reference – your aim should be to go out and create something new, not repeat what has gone before. A more advanced tool is The



Using The Photographer’s Ephemeris, you can check where sunrise and sunset will occur at your chosen location



as possible. If you head to the coast, take a macro lens and keep a look-out for crabs and other creatures that may be lurking in rock pools. Similarly, a macro lens may be useful in the countryside for plants and insects. For more urban locations, search out good places to take documentary or streetphotography images, and there is of course architecture, but don’t forget to include close-up images of details and textures. The aim of the day is variety and keeping yourself entertained. Setting a whole day aside to go exploring gives you ample opportunity to try some new techniques, or to take a friend’s camera or lens for a test drive (see tip 4 on page 65). To get the most out of the experience, photograph as many different subjects and scenes as possible. Of course, it would be unrealistic to expect every image to be a masterpiece, but the day should be a learning experience with every hour offering something different as the light changes. Once you have ﬁnished, why not make a photobook, slideshow or online gallery about your day? Don’t forget to take plenty of self-portraits and photos of your kit, as those ‘behind-the-scenes’ images help to tell the story of your day.
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© RICHARD SIBLEY



Work out exactly where the sun will rise before you set out to take your photographs everything you want to take the night before. It is always a good idea to take a rain jacket and warm jumper, even in the summer, as you don’t want to get caught out by changeable weather. Similarly, leave a blanket in the boot of your car, both in case of emergencies or if you fancy a quick snooze following your sunrise shoot. A bottle of water is also essential. In terms of photographic equipment, you should have a good idea about the sort of equipment you will need based on your chosen location. Put



© RICHARD SIBLEY



Use a good Ordnance Survey map to find public footpaths



together a good basic kit, starting with a 28-70mm f/2.8 lens, or similar, and a ﬁxed optic, perhaps a 55mm macro for a good standard focal length and something that offers macro options. Another good choice would be a 70-200mm lens, or similar, to provide some extra reach should you see any wildlife or a landscape feature you wish to pick out. A good teleconverter that will work with your lenses can be a godsend, expanding the focal lengths available to you but without adding much weight to your bag.



If weight is an issue, then an 18-200mm lens should suit almost any image that you are likely to take. However, it is when shooting on days like this that a compact system camera and its lenses really are beneﬁcial, particularly the smaller micro four thirds or Nikon 1 system cameras. Not only are the cameras smaller, but so are the lenses. This means that your kit selection will weigh far less and ﬁt in a far smaller bag than their equivalent APS-C or full-frame DSLR counterparts. Remember to take plenty of memory cards, as you never know how many photographs you will end up taking. And with that in mind, make sure you pack spare batteries, or have another way to charge you camera, such as via an external battery pack or in your car while driving. This is another advantage of compact system cameras, as some of them can be charged via USB, so battery and incar charging are possible. Finally, take a compact camera. It won’t add much weight, and it may provide a longer zoom than you have on your main camera. Plus, it’s a great back-up option should the battery on your main camera die.
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TOP TIPS your batteries the 1Charge night before a bottle of water and 2Take appropriate clothing your bag packed and 3Have ready to go If you have a smartphone, 4Ephemeris download The Photographer’s app a compact camera as a backup option 5Take
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TAKE A PHOTO WALK



Create a photo walk of your local area, or venture further aﬁeld with our top tips on devising your own shooting tour ALTHOUGH there are
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many companies offering organised photo walks around the country, why not create your own? With the resources available via the internet, it’s never been easier to research and plan your route. Once you’ve decided where you want to take your photo walk – for the purposes of our project we’re using Bournemouth in Dorset – use Google Maps Street View to take a closer look at the area. Locate a landmark, such as the pier, from which to start your photo



walk. Make sure there are car parks or transport links nearby if needed. From here, mark out a route. Street View shows us that we can walk along the seafront to Hengistbury Head passing another pier, or we can walk along the chine and photograph the Pavilion, Coy Pond and the mini golf course. Remember, you may also want to check tide times and sunrise and sunset locations, so you can plan your day to ensure you are in the right place at the right time for great golden-hour photos.



START A BLOG



A blog can give your work exposure and provide a platform from which to advise others



SO MANY of us slave
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away at producing work that we’re proud of, but then ﬁnd we lack a means to show the world our images. This is one of the great things about the internet: it provides a platform for you to showcase your adventures in photography. Sites like Flickr and 500px offer amateur photographers a user-friendly way of putting their work online. Most importantly, they enable other photographers to comment and offer feedback on the images you show. But why not go further and create a website



70 ADVANCED PHOTOGRAPHY SKILLS



dedicated to your work alone? WordPress (wordpress.com) and Blogspot (blogger.com) offer template blog sites that are easy to set up and put work onto. It’s a more personal way of showing the world your images, and one you have complete control over. These sites also allow visitors to comment on your images. Blogs can help to generate a following for your work and allow people to track your progress as a developing photographer. Not only that, but a blog will allow you, if you so choose, to go into detail about how you produced your images and potentially offer advice and inspiration to other photographers. There are many photographic blogs out there that you can visit for inspiration, to demonstrate the potential of creating your own web presence. Not all of them are entirely successful, but that in itself should demonstrate what works and what doesn’t.



HIRE A MODEL FOR THE DAY Club together with some friends and photograph a professional model for stunning portraits and a great skill booster
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DO YOU struggle to ﬁnd friends and family who will pose for you? And even if you do ﬁnd someone who agrees, do they only sit still for ﬁve minutes before they get too bored or embarrassed to continue? If so, a professional model might be the answer to your portrait problems. And by clubbing together with camera-club companions or other friends, hiring a model might not be as
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TAKE A SERIES OF SELF-PORTRAITS



If you can’t ﬁnd someone to photograph, why not take a photograph of yourself? It’s easier than you think FINDING a suitable subject for portraits can be difﬁcult, particularly if you are quite shy. We would suggest asking a complete stranger for permission to take their photograph, but although they may be more receptive than you think, this may be too much of a leap for many photographers. Instead, why don’t you try to photograph the one person who will always be available at the same time as you – yourself! Taking a self-portrait gives you time and opportunity to experiment with posing and lighting. Set your camera up on a tripod and then use the self-timer or a remote release to trigger the shutter. It may take a few attempts before you achieve the correct exposure settings, but once mastered, you can begin to concentrate on posing in front of the camera. As photographers, we tend to be most critical of images of ourselves, which makes us the perfect subjects. You will learn that by angling your head in a certain way, or by opening your eyes a little more, you can create a more ﬂattering portrait, and all the techniques that you learn can then be used when photographing someone else. Similarly, once you have the basic exposure and positioning sorted out, you can begin to play with the lighting, perhaps adding an additional ﬁll light or a reﬂector and adjusting their positions to see what effect this has while shooting.



9 expensive as you ﬁrst thought. Working with a professional model will provide you with a number of beneﬁts. First, they know what they’re doing. They can help suggest poses, props and locations that bring out their best features and they don’t mind being told what to do! As they’re also being paid to be there, there’s no rush, so you can make sure your lighting, settings and composition are perfect. You might be able to ﬁnd local models who will give you some time for free in return for headshots for their portfolio. It’s worth posting an ad on Gumtree (www.gumtree.com) or a similar site. Be warned, though – you



might get some very inexperienced models, so it could be worth going down the agency route after all. Joe Ewaskiw at Model Mayhem (www.modelmayhem.com) gives this advice: ‘Collaborate. Models aren’t just props. Work with their talents to enhance your ideas. Build rapport. Communicate with models clearly and respectfully. If you make a model feel uncomfortable, the photos will show it. And ﬁnally, follow through promptly. If you promised to give photos to the model, don’t delay. One of the biggest complaints models have is never getting the photos. Avoid getting a bad reputation.’
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CRITIQUE



What’s the use of a picture that nobody sees? Try looking for places to get critique for your images, or even critique those of others



THERE are plenty
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of facilities for getting critique on your photos. Social media sites like Facebook and portfolio sites such as Flickr are good places to start, but also keep an eye out for portfolio reviews taking place at galleries in your area. These are a great way to gain feedback in person, which is always worthwhile. Look into magazines too. Amateur Photographer have several facilities for offering guidance and critique: submit photos for Chris Gatcum’s Appraisal column, enter the latest round of APOY, or visit the Appraisal section of our forum to gain feedback from other readers. There is one important point that many people forget, however – one of the fastest ways to gain feedback for your work is to give it to others. Why not speak to photographers you know and ask to give crit for crit? With this in mind, here are a few points that you might want to consider when offering critique:



Think about the elements that make up the image An image



1



should only contain elements that are absolutely necessary to its intended message or effect. Would the image you are looking at beneﬁt from a tighter crop, or some judicious application of the Clone tool? Has the photographer tried to cram too much into the frame, or has he or she gotten a little too close to the subject for its own good?



2



Look at the light Light is a photographer’s bread and butter, and it needs to be used correctly.
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could do with opening up his or her aperture. This could go the other way too – would the inclusion of some more background have made for a more interesting picture?



5



Remember to be honest, fair and speciﬁc to the image We’ve
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What do you like about the image?



all got our pet peeves, but it’s worth trying to get a handle on yours when giving critique. You may not think much of high dynamic range photography or be sick to death of black & white, but that doesn’t mean you get to write off these images as worthless. If they work for that particular image, then they work – be fair.



In whatever genre of photography you encounter, always ask yourself – is the light right in this image? If it’s natural light, ask yourself whether the photographer has shot a picture appropriate to the conditions. If artiﬁcial, examine the effects of the set-up. Does the light need softening? If it’s a portrait, has the subject been ﬂattered?



3



Consider the image’s composition
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Has the photographer used the correct depth of ﬁeld? If a



There is a dedicated area on the AP forum. Why not drop by and say hello?



Take a look at this image by our technical writer Callum McInerney-Riley, which engendered plenty of discussion on his Facebook page. Apply the points above. What works? What doesn’t?



This doesn’t just mean looking along the thirds lines – a central placement of a subject can work perfectly well in the right context. Think about what the photographer was trying to show with the image and ask yourself whether the composition aids that.



cluttered background pulls your attention away from the main subject, the chances are that the photographer
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Easily forgotten, but this is an important one. While constructive criticism is useful, nobody enjoys having their work ripped remorselessly to shreds. Find something positive to say about every image you critique and you are much more likely to make friends than enemies.
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SHOOT FROM THE HIP Shooting from the hip can help you stay under the radar and produce some fantastic street photography



STREET



12



photography has grown in popularity over the last few years. However, achieving that sought-after natural look can sometimes be quite a challenge. Thankfully, cameras are becoming a little more stealthy, but often when people become aware of a photographer taking a picture, the mood and scene suddenly change. Capturing that impromptu moment therefore comes down to



LOOK AT BOOKS AND MAGAZINES



being subtle and discreet. One method to combat this is to shoot from the hip. This avoids raising awareness of your presence, so the scene does not change as you capture your images. If you’re not raising the camera, people do not expect you to be taking pictures. In this situation, an articulated screen can be very useful but not essential. All settings can be preset for the situation while relying on the AF to focus the shot or setting a predetermined focus distance.



WE MENTIONED



With so many books and magazines out there, you’ll never be stuck for ideas
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on page 65 that visiting exhibitions is a good way of getting inspiration for your own work. Another good tip is to delve into the myriad books and magazines that line the shelves of newsagents, bookshops and libraries. Take a wander through the photography section of any good bookshop and look through some of the truly wonderful books that have been compiled by some of the world’s most important photographers. There’s nothing more exciting and inspirational than studying the work of your favourite image-makers. A great number of books are released every month whose premise is built on improving your
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Shooting from the hip allows you to capture an image without drawing the subject’s attention



photography, whether it’s in general terms or by using speciﬁc techniques such as macro and monochrome. There’s no deﬁnitive guide to photography, so it’s worth shopping around for the one that works for you. It’s worth ﬂicking through magazines that aren’t necessarily devoted to photography, such as fashion and lifestyle magazines. Take a look at the images and see if you can work out how they’re done. How were they lit? What works about the composition? How would you have done it differently? Of course, there’s always the option to subscribe to a trusted photography magazine, one in which you can ﬁnd reviews of many of the books you’re likely to look at in the course of your research. Visit www.amateurphotographer.co.uk for details.
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START A 365 PROJECT



2



camera is your number-one companion – carry it with you everywhere you go, learn to use it to it’s full potential, and get creative.



Get your thinking cap on and your creative juices ﬂowing, by taking one photo every day for a year
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Stay organised: Don’t allow a backlog to accrue, sort your photos out every day and post, that way you aren’t left with a massive task, plus posting regularly will help you integrate with the community and get positive feedback on a daily basis.



3



And this is where Project 365 comes in. Project 365 encourages participants to take and share one photo a day. By sharing your photo, you are more likely to follow through with the daily shoots, as well as getting valuable feedback. There are loads of places to share your projects, including Flickr and 365Project.org, the latter of which currently has 80,000 members documenting their daily lives. We spoke to Ross Scrivener at 365Project.org (365project.org/ Scrivna) for his top tips on completing your own project:



Pick a subject... or don’t: Having a theme can be a fun way to watch your life, perhaps 365 selfportraits, or photos of your kids or your cat. Or just your life. Pick something to focus on and just keep taking photos.
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Use your commute to work, your kids playing or perhaps the landscapes you see everyday as inspiration for your own 365 project



ALL IMAGES © HIGHTIDE



IF THERE’S one thing most of us are guilty of, it is not making enough time for our photography. There are so many reasons, excuses really, not to go out for a day shooting – work, family, weather – that our cameras may go untouched for weeks on end. However, a quick adjustment to how you think about photographic time might be all you need to be re-inspired to go out more frequently. Why not spend just ﬁve or ten minutes a day taking a photo? Take your camera on your walk to work, or pull the car over in a lay-by if you see a pretty sunset. Take a photo of your cat, dog or child going about their daily business. Or experiment with still life in the comfort of your own front room. The possibilities are endless.



Learn to use your camera: Your
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Find inspiration: In the early days,
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Keep your eye on the prize: You will



I was often quite stuck for ideas, but it does get easier! Find a photo you like and try to replicate it. It’s a great way of getting a good photo and improving your skills at the same time!



get disheartened, no doubt about it, but never forget why you started the project. After 12 months you will have a huge sense of achievement, and a great diary of your life.
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USE TEXT



You know what they say about pictures and words, but sometimes text can give images a creative spark © CALLUM MCINERNEY-RILEY



IT MAY seem a little gimmicky at ﬁrst glance, but words are powerful tools and sometimes a sprinkling of text can be the unusual touch that will make a picture memorable. A witty caption, an apposite quote or an overlaid title can all be appropriate in the right contexts, and if you are struggling with how to give an image a little extra something, it’s well worth trying out. What’s also worth trying is incorporating text that you ﬁnd in the world into your photos. Look for signs, billboards, even grafﬁti – this is often a great way to get inspired with street photography. Be open to the presence of words in the world around you when making pictures. Also consider being creative with your photo titles. Most people when they’re titling images will provide simply a blank statement of the main subject: ‘Tree’, ‘Kingﬁsher’,
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‘Dorset’ – you get the idea. When titling a picture, try to think more along the lines of what you were trying to say or achieve with the photo than merely what the main subject is. Sometimes this may involve a little research into your subject, but it is worth it. Titles like ‘Elm’s 89th Year’, ‘WeatherBeaten Birch’ or ‘Young Sapling’ are all much more interesting and memorable than ‘Tree’. © CALLUM MCINERNEY-RILEY
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EDIT YOUR IMAGES
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RICHARD SIBLEY



Do you always edit your images in the same way? Try some new techniques and styles to reveal a different side to your photographs



HOURS spent in front of a computer editing a digital image won’t turn a bad shot into a good one, but it can offer a different interpretation of the scene. In the same way that we frequently choose to use the same exposure settings on our camera, we also get very complacent when editing the resulting images, making the same adjustments to the same strengths time and time again. While this does help a collection of images to look like part of a set, sometimes editing the image in a different way can give it a whole new perspective. So next time you sit down to edit an image, why not set yourself the target of editing it in ﬁve different ways? Don’t just click on a default preset adjustment; create a selection of your own and apply them all to the same image and see which you prefer. The way we crop our images is another element to consider. As
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photographers, we all know the standard crop ratios, but these have been determined by the ﬁlm we used or the paper we printed on. Given that most of us now display our images on screen rather than as prints, there is no reason for us to still feel constricted to the usual 3:2 or 3:4 crop ratio. Next time you shoot a landscape image, try cropping it in ﬁve completely different ways using ﬁve different aspect ratios. You may ﬁnd that the original version is the best, but by looking at and cropping the photograph differently, you could uncover a striking shot.



‘Next time you shoot a landscape image, try cropping it in ﬁve completely different ways’
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INFINITY FOCUS



USE MANUAL FOCUS



It can be difﬁcult to use autofocus when photographing subjects in the sky, especially at night. For stars or ﬁreworks, it is best to manually set the lens to inﬁnity focus. How you do this will depend on your lens. For instance, if your lens has a focus distance scale, manually focusing at a set distance is easy, but not all lenses focus to inﬁnity in the same way. Some have a ‘hard-stop’ inﬁnity focus, which means that when you turn the focusing ring to its maximum focus distance it will stop at inﬁnity. However, the focus ring on some lenses can turn slightly beyond inﬁnity. This is where the common belief that you should always focus slightly back from inﬁnity comes from. In fact, what you should be doing is turning the focusing ring until the focus indicator line is in the centre of the inﬁnity symbol. This will guarantee you are focusing on inﬁnity so you can concentrate on composing the image and ﬁring the shutter at the correct time.



Take some time to learn when manual focus is the better option, and how thinking about focus distance can lead to better images



MACRO IMAGES When you take macro images, manual focus should be your default. As the depth of ﬁeld involved in macro imagery is so small, it can be difﬁcult to get precise points in focus using AF. Manual focus gives more control. Manually focusing on your subject via the viewﬁnder can be a little difﬁcult as the display may be a quite dark, especially if extension tubes or bellows have been used. If you have a live-view function, magnify the on-screen image as much as it will go. This will enable you to see tiny details much better.



PRESET MANUAL FOCUS



RICHARD SIBLEY



Using AF, the focus in this image would have been on the centre of the field. Manual focus allows alternative focal points to be chosen for more creative compositions



THE VAST majority of photographers take autofocus for granted, but it wasn’t that long ago that manual focus was the only option. And it still has a huge part to play, particularly if you want to get the most accurate images possible. For some subjects, manual focusing will be far too slow. However, it’s great for the type of shots that most enthusiasts take on a regular basis. You may even ﬁnd the manual method faster and more accurate, as twisting the lens barrel can often be faster than changing the selected
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AF point. Not to mention that some lenses can suffer from front or back focus, causing images to be fractionally softer than they should be. In fact, one way to determine whether a lens suffers from front or back focus is to set a camera on a tripod, use autofocus and take pictures of a detailed subject. For landscapes images, manual focus can be very beneﬁcial, allowing the photographer to use the focus distance scale on the lens to set it to the hyperfocal distance point. This will maximise depth of ﬁeld to make sure that both the subject and background are in focus, to inﬁnity.



Not all lenses have a hard infinity stop, so when manual focusing make sure you actually focus on infinity rather than simply racking the focus ring all the way around
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When taking documentary and street photos, it is often useful to preset the focus manually. By selecting a certain focus distance and aperture, the resulting depth of ﬁeld will make it possible to capture the subject in focus. In this way, documentary photographers are able to use their cameras almost like a point-andshoot, so the camera is ready the moment the shutter is ﬁred, without autofocus getting in the way. For example, when shooting with a 35mm lens on a camera with an APS-C-sized sensor, setting the lens aperture to f/11 and the focus distance to 4.5m will create a depth of ﬁeld extending from 2.47m to 25.7m. This should be more than enough to get any documentary or street subject in focus. So, the next time you are out engaged in this type of photography, use this technique and have more freedom to concentrate on composition and capturing the moment. ADVANCED PHOTOGRAPHY SKILLS 77



20 IDEAS TO INSPIRE YOUR PHOTOGRAPHY



WorldMags.net



SHOOT AT MAXIMUM APERTURE



F/2.8



It is all too easy to switch your aperture to f/8 and simply ﬁre away, but shooting with a large aperture and a shallow depth of ﬁeld will change your view of the world ALTHOUGH a large depth of ﬁeld is perfect for many types of photography, it can create something of a point-and-shoot mentality. So instead of relying on f/8 or f/11, why not open your lens aperture as wide as it will go, or perhaps 1 stop down from there for better quality? When shooting at f/2.8, f/1.8 or even f/1.4, there will be a very shallow depth of ﬁeld. Use it to your advantage to look at scenes in a completely different way. By focusing on foreground subjects, objects in the



18



background will be completely out of focus and show as a mere blur, and vice versa. By restricting yourself to using a shallow depth of ﬁeld, you will naturally start to look for opportunities to use this effect creatively. It becomes easy to isolate subjects against a background, to create a sense of mystery, or conversely, to make the foreground a real feature of your image by blurring it completely, showing only the background in focus. So why not set your camera to aperture priority, the lens aperture to its maximum setting and try shooting for an entire day without changing it?



Shooting with a very shallow depth of field, so that background details are thrown out of focus, allows you to really draw attention to the subject and think creatively
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F/1.8



F/2
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PRINTING



It’s all online these days, right? Not quite, as there’s still nothing to match the endurance of a physical print
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TAKING and



conveying a message or story, and you don’t need to power up any devices before you can see them. Looking at the printed image will help you to further analyse the composition and other technical matters. Things that may not have been obvious on a computer screen will stand out on a print. A printed image has a greater perceived value and it’s looked at with more focused interest. Use the manufacturers’ recommended inks and paper, and prints can last for up to 200 years. Printed photographs will be around for longer than many of today’s mobile devices, including hard drives and removable drives that can be discontinued in favour of newer technology.



© VINCENT



OLIVER



sharing photos has never been easier. You can instantly send pictures to the other side of the world directly from a mobile phone or Wi-Fi-enabled camera. Yet while looking at photos on a small mobile device is convenient, it doesn’t have the same impact as a print. Printing photographs has, from the outset, been at the heart of photography, but how many people now take the time to print their digital images? Prints are easy to hand around and talk about with a small group of people, while larger prints have greater impact displayed in a home or gallery. Prints are a powerful medium for instantly
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CREATE A PHOTO ESSAY



Weaving a narrative through a series of images is a fun and engaging way of understanding the story-telling capabilities of photography RIGHT from the
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outset, photography’s pioneers understood that the medium was, at its heart, much more than just a means to record images of the surrounding world. Artists such as Hippolyte Bayard and William Henry Fox Talbot saw the potential for the medium to act as a conduit for one of our most cherished human traits – the desire to tell stories. Photography has an innate ability to educate, inform and entertain, either through single images or through a succession of frames. It wouldn’t be unfair to suggest that most of us spend our time attempting to communicate our ideas through a single frame, but what if you want to take that a step further? Take a look back through some of
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the work produced by the signiﬁcant photographers whose talents were honed under the guidance of such major publications as Life and National Geographic, and you’ll see the exciting potential of creating a story through a group of images. Creating photo essays is not only great fun, but it’s also a good way of sharpening your skills and instincts as a photographer. Photo essays can be about anything. They can be about a local shop, an exciting event, a person’s day-to-day life or even about what your cat gets up to when he or she thinks you’re not looking. Here we take a look at a simple photo essay so you can get an idea of the potential of such a project.



THE PHOTO ESSAY Every good photo essay can be essentially broken down into ﬁve



components: the establishing shot, a portrait, an action shot, a detail shot and a clincher. Of course, these are relatively malleable suggestions, but it’s a good starting point. There are a variety of steps that can be inserted and there is potential to create more than one image for each section. However, for the purposes of illustration we’ll focus on these ﬁve steps. One thing that’s worth noting before you start is that you should try to maintain a consistent visual style throughout the photo essay. This applies to things such as angle of view, lighting and colour, so your images will function better together as a set.



The establishing shot This is often a wideangle shot to establish the scene. The reason for this is that a photo essay is a journey. You’re taking
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your viewer somewhere they’ve never been before, so it’s important to place them within the scene so they can get their bearings. You are essentially placing the story in context.



The portrait Here’s where we



2



meet the protagonists of your story. These are the people who will guide us through the rest of the images. What you are attempting to establish here is their role within the wider story. This is perhaps the trickiest aspect of the overall project, but it’s also the one that you’ll learn the most from. There are, of course, simple things you can do to make this person’s or group’s role clear. If they work at the shooting gallery at the visiting fun fair, make sure you show them behind the counter, BB gun in hand. If your subject makes their living as a farmer, show them in a ﬁeld ﬂaunting their mud-encrusted wellington boots. Alternatively, you can take the opposite approach and shoot your portrait as a tight headshot. This shot sounds simple, but through this one image you’re attempting to introduce a character with which your viewers should be able to ﬁnd some
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Here we see a simple example of a photo essay. This story deals with a peace camp called Democracy Village, set up in Parliament Square in May 2010
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level of emotional engagement. The important thing is to shoot a variety of portraits, some candid and some posed.



The action shot This is the image that will focus on your subject’s interaction with their environment. It’s the one that will show their reason for being in the chosen location. To take a couple of simple examples, it could be a shop assistant interacting with a customer or a Thai boxer working out his or her aggression on a punch bag. This is where we see the story truly developing, as it will give a human dimension to your character.
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The detail shot We can learn much



from getting a little closer to the subject, as this will highlight a particular element of your story. While detail shots don’t necessarily contain much in the way of individual narrative, they are a key component in narrative progression. Think of it as dramatisation. Perhaps you’ll get close in on the character’s hands as they apply icing to a cake or brush strokes to a canvas. There are many forms this shot can take.



The clincher This is the shot that will close the story and deliver the emotional pay-off. What is the end of the process? What has this story been about? This is where we ﬁnd out. Is it a policeman placing a suspect under arrest or a customer walking away with their custom-made zoot suit? This is perhaps the most important shot of the sequence and the one that will become clear to you, the photographer, as the shooting process develops.
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APS-C-FORMAT DSLR KIT LENS UPGRADE Upgrading from a standard-zoom kit lens to a premium lens can breathe new life into a camera, with sharper images and greater versatility



There are many options when considering an upgrade from an 18-55mm f/3.5-5.6 lens. A standard zoom with a constant f/2.8 aperture is a great option
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FACTS & FIGURES



MOST APS-C-format DSLRs, especially consumer models, come packaged with a lens, usually a standard 18-55mm f/3.5-5.6 zoom. This lens is supposed to be a starting point for those venturing into the world of DSLR photography, so obviously it won’t be the best-quality lens in the manufacturer’s range. With the resolution of APS-Cformat DSLRs now reaching 24 million pixels, the limitations and ﬂaws of most kit lenses are becoming more obvious as the high resolutions make large prints possible. Resolution is just one consideration, though. Even in small prints, curvilinear distortion and chromatic aberrations will be evident. Furthermore, wide apertures in premium lenses can provide camera settings that produce less noise and allow the camera to be used in a wider range of situations. The 18-55mm kit lens does have something going for it, though, as its zoom range covers most photographic subject matter, be it landscapes, portraiture, street or travel photography. Using image-workﬂow software, it only takes a quick look at the focal-length metadata in the image folders to see this is true, and that these focal lengths are the most often used. As such, the reason for upgrading a lens should be about more than just focal range, even if wildlife or sports photography is your main interest. For example, an 18200mm lens may offer a wider reach and allow you to get closer, but it will not necessarily improve the quality of images over an 18-55mm optic. So, to reiterate, it’s about quality, not quantity. Most of the main DSLR manufacturers have a premium lens with a similar focal length to 18-55mm (such as 17-55mm, 17-50mm or 16-50mm), but with a constant f/2.8 aperture. While these lenses are larger, heavier and more expensive, once again the focal range covers everyday use, which makes them possibly the best option for an upgrade. In this feature we have the current 18-55mm kit lenses from Nikon, Canon and Pentax, and each brand’s equivalent ‘upgrade’ lens. We also have third-party options from Sigma and Tamron. The aim is to run image-quality comparison tests of the less costly kit lenses against the premium optics, covering aspects such as centre and corner sharpness, and lens distortions. There are additional beneﬁts to the handling of the premium lenses too, which have also been considered. While we have used a number of lenses, the text often refers to kit and upgrade lenses in general, because much of the information can be applied across all the optics.



CANON EF-S 18-55MM F/3.5-5.6 IS II



CANON EF-S 17-55MM F/2.8 IS USM



NIKON 18-55MM F/3.5-5.6 GII AF-S DX



Street price Mount



Around £145 Canon EF



Around £640 Canon EF



Around £120 Nikon F



Construction Aperture range Aperture blades Minimum focus Filter size Size Weight



11 elements in 9 groups f/3.5-22 (wide), f/5.6-38 (tele) 6 0.25m 58mm 68.5 x 70mm 200g



19 elements in 12 groups f/2.8-22 7 0.35m 77mm 83.5 x 110.6mm 645g



7 elements in 5 groups f/3.5-22 (wide), f/5.6-38 (tele) 7 0.28m 52mm 70.5 x 74mm 205g



Canon, Woodhatch, Reigate, Surrey RH2 8BF. Tel: 01737 220 000. www.canon.co.uk



Canon, Woodhatch, Reigate, Surrey RH2 8BF. Tel: 01737 220 000. www.canon.co.uk



Nikon, 380 Richmond Road, Kingston upon Thames, Surrey KT2 5PR. Tel: 0330 123 0932. www.nikon.co.uk



Kit lens Upgrade lens



BUILD AND HANDLING



THE FIRST thing to note when comparing upgrade and kit lenses is the difference between them in size and weight. Of course, each lens is different, but the 18-55mm kit lenses are around 30% smaller than the
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upgrades, and typically weigh in the region of 200g. Upgrade lenses are around three times heavier, starting with the Sigma 17-50mm at 565g, while the heaviest in the group is the Nikon 17-55mm at 755g. For
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NIKON 17-55MM F/2.8G ED-IF AF-S DX



PENTAX SMC DA 18-55MM F/3.5-5.6 AL WR



PENTAX SMC DA* 16-50MM F/2.8 ED AL (IF) SDM



SIGMA 17-50MM F/2.8 EX DC OS HSM



TAMRON SP AF 17-50MM F/2.8 XR DI II VC LD ASPHERICAL (IF)



Around £1,050 Nikon F



Around £160 Pentax K



Around £850 Pentax K



14 elements in 10 groups f/2.8-22 9 0.36m 77mm 85.5 x 110.5mm 755g



11 elements in 8 groups f/3.5-22 (wide), f/5.6-38 (tele) 6 0.25m 52mm 67.5 x 68.5mm 230g



15 elements in 12 groups f/2.8-22 9 0.30m 77mm 98.5 x 84mm 600g



Around £310 Canon EF, Pentax K, Nikon F, Sony Alpha, Sigma 17 elements in 13 groups f/2.8-22 7 0.28m 77mm 83.5 x 92mm 565g



Around £350 Canon EF, Pentax K, Nikon F, Sony Alpha 19 elements in 14 groups f/2.8-22 7 0.29m 72mm 79.6 x 94.5mm 570g



Nikon, 380 Richmond Road, Kingston upon Thames, Surrey KT2 5PR. Tel: 0330 123 0932. www.nikon.co.uk



Pentax Ricoh Imaging, Pentax House, Heron Drive, Langley, Slough, Berkshire SL3 8PN. Tel: 0870 736 8299. www.pentax.co.uk



Pentax Ricoh Imaging, Pentax House, Heron Drive, Langley, Slough, Berkshire SL3 8PN. Tel: 0870 736 8299. www.pentax.co.uk



Sigma, 13 Little Mundells, Welwyn Garden City, Hertfordshire AL7 1EW. Tel: 01707 329 999. www.sigma-imaging-uk.com



Tamron, Intro 2020 Ltd, Priors Way, Maidenhead, Berkshire SL6 2HP. Tel: 01628 674 411. www.intro2020.co.uk



a consumer-level DSLR – a Canon EOS 700D or Nikon D5300, for example – an upgrade lens makes for a front-heavy combination as the lens is heavier than the camera body. For comfortable use, one must rest



the lens in the left hand rather than taking most of the weight with the camera hand. The Pentax K-5 II with 16-50mm lens is well balanced. The main reason for the extra size and weight of an upgrade lens



is the complexity of its design. Lens elements are not only larger and heavier, but they are also greater in number by 30-50% (see above). Better-quality glass will give sharper images across the entire frame.



Of the lenses in this group, the Canon and third-party models offer image stabilisation, while Pentax offers stabilisation in its cameras rather than in its lenses. The Nikon kit lens includes stabilisation, but the upgrade lens does not. At the tele setting of these lenses stabilisation is handy, providing in the region of 3EV of extra shake-free shutter speeds when shooting handheld. With no stabilisation, higher ISO settings are required for faster shutter speeds, which can compromise image quality, so the Nikon upgrade lens is at a disadvantage here. Any differences in the minimum close focusing is negligible, with none closer than 25cm and generally all the kit lenses able to focus 5cm closer than their upgrades. Finally, a physically larger lens will require a larger ﬁlter thread diameter, so those upgrading will need to consider larger (and more expensive) ﬁlter replacements. There is not just a large difference in size between a kit lens and an upgrade lens, but the upgrades are much heavier too
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APERTURE AND DEPTH OF FIELD THE MAXIMUM aperture is an important factor in how well a lens copes with a variety of lighting conditions. In this respect, a kit lens is restricted. All three kit lenses in this feature have a maximum aperture of f/3.5, which is reduced to f/5.6 at the telephoto end. All the upgrade lenses offer a maximum f/2.8 aperture, no matter what the focal length, which allows more light to enter. When shooting at the telephoto end, the upgrade lens offers a 2EV advantage, which is reduced to 0.7EV at the wide end. This 2EV of extra light at 50mm makes the upgrade lens a much better option for low-light and high-speed photography. It allows a faster shutter speed for the ‘correct’ exposure. This, in turn, may remove the need for a tripod and will certainly allow the use of a lower ISO setting, which is ideal for crisp images. For the sharpest images, we always recommend stopping down 2EV or



50MM



more from the widest aperture. So, to get the best results from the kit lenses at 50mm, one should stop down from f/5.6 and use f/11; with an upgrade lens, f/5.6 is itself 2 stops down from f/2.8. Portraits gain a more ﬂattering distortion-free perspective when taken at the tele-end of these lenses, rather than wide. So not only does the upgrade lens offer better control for low-light work, but there is also greater control over depth of ﬁeld for ‘ﬂattering’ portraits. An f/2.8 aperture enables a notably shallower depth of ﬁeld than f/5.6. If, however, one generally shoots in good light using an f/11 or f/16 aperture – for example, a landscape in sunny conditions – such beneﬁts to an upgrade lens do not apply.



18MM



With the scene framed the same at the 18mm and 50mm focal lengths of a standard zoom lens, barrel distortion is obvious at the wide end, while the tele end is virtually distortion-free



KIT LENS AT ISO 6400 AND F/5.6



UPGRADE LENS AT ISO 1600 AND F/2.8



These close-ups show the advantage an upgrade lens has at its tele end, due to its larger maximum aperture. It enables an ISO setting 2EV lower, providing crisper results
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17-55MM



DISTORTIONS



CHROMATIC ABERRATION



CURVILINEAR DISTORTION



Both lens types suffer from barrel distortion at the wide end. In realworld images, with each lens type set to 18mm, the difference is hard to see between the Nikon lenses. It is slightly more obvious, however, when comparing the Pentax and Canon kit lenses with their respective upgrade options. Applying distortion corrections can lead to detail right at the edges of the frame being ‘lost’ outside the frame. At the tele end of each lens, there is minor pincushion distortion.



While there is a difference in edge sharpness between a kit lens and an upgrade lens, any differences in the degree of curvilinear distortion is, for the best part, minimal. For reference, the degree to which distortion is evident can be seen in a raw ﬁle by ticking and unticking the lens corrections box, which in Adobe Lightroom is called Enable Proﬁle Corrections.



RESOLUTION CANON 18-55MM F/3.5-5.6



18-55MM



Chromatic aberration (fringing) takes on different characteristics in the lenses on test here. As with distortions, ticking and unticking the Remove Chromatic Aberration box shows how severe fringing can be, most notably at the edges of the frame and when the lens is set to its wide focal length. Most fringing has gone at the tele-end of each lens. When comparing kit and upgrade lenses, one of the most obvious differences is in the Canon models. The Canon upgrade lens is the most effective at controlling fringing



Edge detail is where we see the biggest differences between kit and upgrade lenses. The premium lens is sharper and handles chromatic aberration better of all the lenses here, but the kit lens is one of the worst affected. Both Pentax lenses (even the upgrade) suffer badly from fringing. Of course, these distortions can for the best part be removed with the press of a button in software such as Adobe Camera Raw or Lightroom, making them not nearly as much of an issue as soft edge detail.



The Nikon and Sigma lenses have been tested using the Nikon D5200, the Canon and Tamron lenses using the Canon EOS 650D, and the Pentax lenses with the Pentax K-5 II, all set to 50mm. The f/2.8 aperture is not available with the kit lenses



CANON 17-55MM F/2.8



NIKON 18-55MM F/3.5-5.6



PENTAX 18-55MM F/3.5-5.6



PENTAX 16-50MM F/2.8



SIGMA 17-50MM F/2.8



TAMRON 17-50MM F/2.8
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NIKON 17-55MM F/2.8
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SHARPNESS



SHARPNESS



VERDICT



UPGRADE LENS CORNER



KIT LENS CORNER



UPGRADE LENS CENTRE



KIT LENS CENTRE



CENTRE SHARPNESS Our resolution charts (see page 87) have been recorded using the 50mm setting of each lens, and indicate centre sharpness. When each lens is used at an optimal aperture, such as f/11, the results indicate that the difference in centre sharpness between the upgrade and kit lenses can be minimal – except for the Canon lenses, where the kit lens is notably softer. The Canon upgrade lens has the edge over the Tamron optic, while the Sigma lens has a slight edge over the Nikon upgrade model for centre sharpness. Resolved detail should not be compared across Nikon, Canon and Pentax-ﬁt lenses, because each has been used with a different camera. However, in spite of the Pentax camera’s lower resolution, its kit lens matches the resolution of the Canon kit lens. Generally, upgrade lenses have a slight edge for centre sharpness, but only under close scrutiny in real-world images. Results from an optimal f/11 aperture only paint half the picture for everyday use, because a wider aperture may often be used. For instance, f/5.6 is also an optimal aperture on an upgrade lens, but this is not the case for a kit lens at the tele-end where detail is softer. In this case, the upgrade lenses outperform the kit lenses at the f/5.6 setting. For critical, crispest results from a kit lens, it needs to be stopped down to around f/7.1 at its wide end and f/11 at its tele-end, which counts out most sharp, shallow-depth-of-ﬁeld work. 88 ADVANCED PHOTOGRAPHY SKILLS



There is a big difference in the quality of detail at the edge of the frame between a kit and an upgrade lens, but in the centre of the frame it can be minimal



CORNER SHARPNESS No matter what the aperture or focal length (but particularly at the wide end), the quality of detail at the edges of the frame is signiﬁcantly more compromised in each kit lens than it is with the upgrade lens. Some lenses suffer more at the edges, notably the Canon 18-55mm. If edge detail is important to your work, then an upgrade lens is a much better option. Landscape photographers in particular will appreciate the crisp detail that



an upgrade lens provides right to the edges, in subjects such as trees and grass in ﬁelds. Portrait photographers may not be so fussy, given that the key details of a subject are usually in a central part of the frame. A drop-off in quality in the corner of the frame is signalled by soft detail – at times even to the point of a hazy glow around the edges of subjects. Detail can be stretched too, due to curvilinear distortion. Premium lenses are not free from curvilinear distortions at the wide focal setting, but thanks to the betterquality glass, edge detail is still crisp. The Sigma lens has a more notable drop-off than other upgrade lenses from its centre to its corner sharpness.
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OUR TESTS indicate several beneﬁts that one can expect from an upgrade lens. With a faster maximum aperture, the optimum setting for sharpness is reached up to 2EV quicker on an upgrade lens, which beneﬁts low-light work, high-speed photography and shallow-depth-of-ﬁeld work. However, when both lens types are used at their optimum apertures, detail in the centre of the frame is by and large rather similar, with the exception of the Canon lenses. The Sigma optic puts in a particularly impressive performance at the centre. All lenses suffer from chromatic aberrations to a degree, but this can mostly be removed using editing software. The Pentax lenses suffer more severely and require more time tweaking the chromatic aberration sliders to get the reduction just right. Shoot wide, and edge sharpness in a kit lens is generally poor, whereas edge details are much crisper with an upgrade lens. Those shooting landscapes will appreciate the consistent quality of detail over the entire frame, and not just the centre. Out of the three branded lenses, there is the most notable difference between Canon’s kit and upgrade offerings – the kit lens suffering more severely from soft detail. It is the poor-quality edge detail from a kit lens that one just cannot get around. Improved performance does come at a cost, however, as well as weight and bulk. Those considering pairing an upgrade lens with an entry-level DSLR should be aware that the big lenses will make for a frontheavy set-up. All in all, there are many areas that beneﬁt from an upgrade lens. Such lenses are able to do justice to today’s higherresolution, APS-C-format DSLRs, enabling sharp prints across the entire frame. The ﬂexibility that upgrade lenses offer in low light and for depth of ﬁeld are key, too. So, while an APS-C camera is available with a kit lens, it may be worth buying the camera in its bodyonly form, and then factoring in the extra cost of a premium lens instead.
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PORTABLE PROJECTORS Want to be able to display your photographs at a moment’s notice? Here’s what to look for in a portable projector, and three models go under the microscope PORTABLE projectors are lightweight units that are small enough to ﬁt in a satchel or even a shirt pocket, and can be used anywhere to instantly display your photographs and movie ﬁles. As with most photographic equipment, the lens quality has to be good. The pocket projector’s lens will probably be a ﬁxed focal length, which means you have to move the projector either closer or further away from the screen to reduce or enlarge the projected image. Generally, the optimum viewing distance is 2-3 metres (6-9ft), which should produce an image size
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of 0.25-1.5m (10-60in). Bigger projectors usually incorporate a zoom lens, which enables the user to enlarge or decrease the image size without moving the projector.



FOCUSING Focusing is accomplished manually using a small wheel located near the lens. One problem with small projectors is that they need to be carefully aligned to the screen to avoid a keystone effect (this is when the image is distorted, giving the projected image a trapezoid shape), although more expensive projectors can automatically remove any keystone



distortions. These small projectors also include a tripod socket at the base, which is useful when setting up.



ILLUMINATION Pocket projectors use LCOS (liquid crystal on silicon), laser or LED lights to deliver rich colours and still allow the projector to run cool. LED lamps have a life of approximately 20,000-30,000 hours. However, the downside of small lamps is that they often lack brightness, which can vary between10 lumens and 200 Most portable projectors have a mini HDMI port, USB port and an SD memory card slot
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lumens, with the higher lumens values producing a brighter display. The contrast ratio, which is a measure of the contrast between the brightest white and darkest black the projector can display, can also vary greatly. Higher ratios provide better pictures, especially in bright environments. For the best viewing, you should use the projector in a dimly lit room together with a brilliant white screen. A good alternative is to use a large collapsible white reﬂector as a portable screen.



RESOLUTION The resolution for most pocket projectors is 854x480 pixels or 640x480 pixels, providing a screen aspect ratio of 16:9 or 4:3 respectively. This is ﬁne for most viewing, including DVD playback, but will not do full justice to your 16-million-pixel image ﬁles. Highresolution, full HD video ﬁles of
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WorldMags.net PHILIPS PICOPIX PPX3610 POCKET PROJECTOR Around £350 www.philips.co.uk



The brightest model in the Philips PicoPix range, the PPX3610 puts out up to 100 lumens on AC power, with a contrast ratio of 1000:1. It has a native resolution of 854x480 pixels and projects a screen size of 12-120in from distances of 0.5-5m. Input options include HDMI, USB and mini-USB, as well as an SD card slot and built-in Wi-Fi.



VIVITEK QUMI Q5 Around £480 www.vivitek.co.uk 1280x720 pixels and 1920x1080 pixels will be downscaled to the lower resolution. Projectors that have the highest contrast ratio, brightness and resolution will display the best picture quality.



POWER As portable pocket projectors use a lithium battery, look for a projector model that has a removable battery so you can carry a spare one with you. A fully charged battery should last for approximately 90mins on a low-light setting or 45mins at maximum brightness. Some units can deliver a viewing time of 90180mins, but this will generally be at a reduced brightness. Other power options include a mains adapter that you can use when viewing a feature ﬁlm on DVD. Units that are iPhone-compatible can also deliver power to an iPhone to provide a useful three hours of extra time, which is handy for the busy photographer on the move.



CONNECTIONS Connections usually include a mini HDMI port that is used to connect a



digital camera, camcorder or DVD/ Blu-Ray player; a composite AV socket; a USB port for a cable or memory stick; and an SD memory card slot. Some projectors may also include internal memory, which can be used to store photographs or presentations. An audio-out port is used for connection to an external ampliﬁer, powered speakers or headphones. Other connectivity options may include direct links to iPhone, iPad, iPod and other Android devices. Most projectors include an infrared remote control, which is useful for controlling slide shows or pausing videos.



SOUND Given that it’s a portable device, you are not going to get a concert-hall sound from a small projector with a built-in speaker or speakers that have an output of 0.5-1.5 watts. At best, these will produce a similar sound quality to that obtained from a tablet device or phone. Projectors that incorporate an audio-out port can be connected to headphones or an external ampliﬁer for a more dynamic sound quality.



The Vivitek Qumi Q5 weighs 0.49kg and has dimensions of 160x104.2x32.3mm. It offers 500 lumens of brightness, a high 10,000:1 contrast ratio and a native resolution of 1280x800 pixels. It also features vertical keystone correction of ±40°. Connectivity options include HDMI, USB, A/V-in, audio jack out and universal I/O input. There is no built-in Wi-Fi, although there is the option to purchase an additional Wi-Fi dongle.



EPSON EB-1761W Around £750 www.epson.co.uk Larger mobile projectors such as the Epson EB-1761W are still slim enough to ﬁt in a laptop bag or satchel. This model measures 292x210x44mm, weighs 1.68kg and, with its larger lamp, produces up to 2,600 lumens of brightness with a contrast ratio of 2000:1. It features keystone correction of ±30° on both axes. Connections include HDMI, USB, jack audio and a component-in socket for a computer.
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CABLE-RELEASE SYSTEMS IOSHUTTER



From the classic cable release to the high tech, we look at six different cable-release systems



£59.95



enlightphotopro.com The ioShutter device provides a remote-release cable for Canon or Nikon cameras that is controlled via an app for Apple iPhones. Sadly, no Android version is currently available. The simple interface of the ioShutter app replicates the look of a classic release switch, but there are some sophisticated features, such as timer and bulb modes that allow precise shutter durations to be set. The Lapse mode provides an intervalometer for setting timelapse intervals, while the more novel Sound and Shake options use the iPhone microphone or accelerometers to trigger the



HAMA TIMER REMOTE RELEASE DCC SYSTEM BASE £59.99



uk.hama.com The Hama Timer Remote Release is very similar to the Phottix controller in terms of look and feel (see opposite page). However, the Hama remote has a detachable cable that uses a screw-locking jack. This means different cables can be bought so it can be used on different cameras without the need to buy a whole new remote. It doesn’t feature 92 ADVANCED PHOTOGRAPHY SKILLS



the slide-to-lock shutter button offered by the Phottix, but instead bulb controls can be started or stopped with the main button and gauged by using the second counter on the LCD. The remote has a designated button to illuminate the LCD. The functions offered by the remote include self-timer, intervalometer, bulb and single shot.
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camera’s shutter when there is a noise or the iPhone is moved. If you have an iPhone, the ioShutter cable is a very useful device to keep in your camera bag, especially given the additional programmable functionality that the app provides.



CABLE-RELEASE SYSTEMS
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www.triggertrap.com Triggertrap is an exciting gadget that uses a smartphone to trigger a digital camera. A Triggertrap dongle can be bought directly from the Triggertrap website or it can be bought as a kit that includes a cable to attach the dongle to the camera’s cable-release port. Once connected, using the free downloadable iOS/Android app, a wide range of different triggering options are available. The standard onetouch triggering and bulb are featured, but interestingly it includes an intervalometer with a variety of settings for time-lapses. These include Bulb Ramping for day-tonight-time lapses, Distance Lapse, which works via GPS and releases the shutter when a predetermined distance has been travelled, and HDR time-lapse for images with a higher dynamic range. The app is easy to use and offers a lot more than most conventional cable releases.



PHOTTIX TR-90 £49.99



www.phottix.co.uk Phottix specialises in making various photographic accessories, from ﬂash triggers to this, the Phottix TR-90 digital timer and remote shutter release. This is a multi-functional remote with a built-in intervalometer. It also includes a self-timer function, longexposure timer, bulb function, interval timer and a timer delay of 0secs to 99hrs 59mins 59secs in 1sec intervals. The main shutter button can be pressed for simple single shots or held for bulb control. Also, the button can be locked by sliding it upwards and then unlocked by sliding it down again. The cable from the remote extends to 1m in length and is not detachable from the remote. A handy LCD illuminator is a very useful addition, as is the on/ off controllable beep that sounds every second that has elapsed when shooting.



HÄHNEL HRC 280



POCKETWIZARD PLUSX AUTO-SENSING TRANSCEIVER



£24.99



£79.99



www.hahnel.ie



www.pocketwizard.com PocketWizard’s PlusX radio trigger is a device for the remote ﬁring of portable and studio ﬂash heads, which is fully compatible with the company’s more expensive and highly regarded Plus III transceivers – on test here is its remote shutter-release feature. With the unit attached to a camera via an accessory cable, the camera shutter is released by a second PlusX. The controls are simple and well laid out, and apart from the on/off switch there is a large test/ﬁring button and a rotary dial for the ten radio channels. The numbers are backlit, which is very useful in a studio setting. As a camera trigger, it worked faultlessly every time with just a cursory glance at the instructions to understand the process. Power is provided by two AA batteries.



This no-frills remote is the simplest model on test. It doesn’t have an intervalometer, an LCD screen or a smartphone app. It is a straightforward cable release that is designed for taking single/continuous shots or long exposures in bulb mode. Like the Phottix remote (above left), it features a push-down, slideup lock system to allow the user to take long exposures or continuous shots without holding the button down. A detachable cable connects via a jack in the top of the remote. This allows other cables to be used with the remote. A big advantage of the Hähnel remote is the fact that it is very small and lightweight. If single-shot, continuous and bulb functionality are all that’s needed, this is an ideal travel remote and generally a great addition to anyone’s kit.
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CHECK A SECOND-HAND LENS Buying second-hand lenses can save you some serious cash, but when faced with what seems to be a great offer it pays to check the optic to make sure you really are getting a bargain. Like anything that you buy second-hand, a used lens is likely to show some signs of wear, but unlike a used car it doesn’t have an odometer to reveal the extent of that use. However, a thorough inspection can provide all the clues you need and give an idea of the true value of the lens. Here we show you how to identify a few issues that could also win some bargaining power to bring the price down even further



APERTURE BLADES



Check that the aperture closes and opens across its full range. If possible, close the aperture down with the lens detached from the camera to allow it to be checked from both sides. Look for signs of oil on the blades as this can signal trouble for the future because it usually leads to the blades sticking. Use the camera’s depth-of-ﬁeld preview control to close the aperture down as far as possible while looking and listening to ﬁnd out if it snaps down and reopens quickly. Also, look through the viewﬁnder to see if the view becomes dark evenly across the image frame. A sticky aperture may open or close slowly, or unevenly, or not at all, with obvious problems for exposure. This can be resolved with a service.



VISUAL INSPECTION The ﬁrst step is to check the lens visually and look for any signs of damage, scratches on the elements and/or barrel, or dust, fungus or even bugs or mites inside the barrel. Marks on the outer elements can often be removed with a blower and a good-quality glass cleaner such as ROR Optics Cleaner (around £5 for 1oz), and apart from those older lenses that unscrew for cleaning, most dirt inside the lens can only be dealt with by a service. With an expensive lens, it’s worth considering the price of a service (they usually start at around £35) as part of the acquisition cost, but it may not be worth it for cheaper optics. Also, look for signs that the lens coatings have eroded. Small missing patches shouldn’t cause too much of a problem, but extensive areas will mean ﬂare may be more of an issue. Lenses with large scratches or chips, especially on the rear element and near the centre, should be avoided, but a few ﬁne scratches are less of an issue. If you can see what appear to be bubbles or discolouration in the elements of a lens as you peer through it, the cement between two elements may have degraded and started to separate. This type of damage can affect image quality and repairing it can be expensive and/or impractical. Avoid lenses with heavy fungal growths as the glass coating may be destroyed and even a thorough cleaning will not be able to restore the lens to its former glory. 94 ADVANCED PHOTOGRAPHY SKILLS



SWITCHES AND LOCKS



Some modern lenses have switches that select auto or manual focus, or activate the stabilisation system. Check that these still function and whether they feel loose or slide into place correctly. There may also be a lock that is designed to stop the lens from extending when it is being carried – this should also be checked.
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ZOOM ACTION



Rotate or push and pull the zoom ring and feel for any sloppiness, grittiness or stiff points in the movement and see whether it works across the full focal-length range. A loose zoom action won’t usually affect the optical performance of the lens, but it can be problematic when shooting with the lens tipped up or down as the focal length may change uncontrollably. A layer or two of insulating tape over the smaller part of the barrel can be all that’s required to rectify this problem. It doesn’t look especially attractive, but it’s cheaper than a service that may not be able to rectify the problem in the longer term anyway.



CHECK LIST Run through this checklist before buying any second-hand lens to be sure you know what you are getting and are paying a fair price: Lens caps Lens hood Box Filter rings Damage to barrel Focus Zoom action Dust, fungus, bugs inside the lens Aperture blades oily or sticking Lens coatings Chipped or scratched lens elements Separated lens elements Switches



PARTS



Small items like lens caps and hoods are easily lost, but they are also easily replaced. If the lens is presented without front and rear caps it suggests that it hasn’t been carefully looked after, so check for signs of damage to the elements. At the very least the cost of replacing the caps and/or hood should be reﬂected in the price. Although it makes little practical difference, a box with all the manufacturer’s documentation can be a sign that the lens has had a careful owner and it makes the lens more attractive to prospective buyers if you later decide to sell it on. The original box is also the best packaging in which to post a lens.



FILTER RINGS



Being at the end of the lens, the ﬁlter rings are prone to damage so check that they are functional. Metal rings can become dented, but with a bit of care and attention from a technician they can be made good. Polycarbonate ﬁlter rings are more likely to crack or chip if they are knocked, so check whether the full depth of the thread is present and whether it can hold a ﬁlter in place. Filter rings tend to gather dust and grime that can make it difﬁcult to attach (or remove a ﬁlter), so it is advisable to give them a good blow with a can of compressed air and a wipe with a cloth before attempting to mount a ﬁlter. If the lens has a ﬁlter attached, check that it can be removed.



FOCUS



The best way to check if a lens can focus is to mount it on a camera and take a few shots with it focused at the closest point, at inﬁnity and at several points in between, and then inspect the images. If it is a zoom lens, check the focus across the focal-length range. Also, rotate the focus ring to see if it moves smoothly without any loose or sticking points. If the lens rattles when shaken gently, it may mean that one or more of the elements or groups is loose. If the glass is still held in place in the barrel, focusing may be unaffected, but it could be a sign of problems to come.
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LEARNING TO LOVE THE FLAWS An older lens may have its ﬂaws, but that’s no reason to consign it the scrapheap. We explain how you can use the imperfections creatively to produce striking effects



HALF the fun of using older second-hand lenses is giving them a whole new lease of life in the digital age. Without the complex lens coatings, electronics and mechanisms used in modern lenses, older lenses have distinct qualities that often can’t be found anywhere else. While some people may think of these features as ﬂaws, other photographers see them as a creative opportunity. So instead of dismissing older lenses, why not learn to use them to create some unique images?



FLARE LENS ﬂare and ghosting can be an issue for older lenses that lack the sophisticated coatings found on modern optics designed for digital sensors. However, rather than avoid situations where ﬂare may be an issue, why not shoot images in conditions that are speciﬁcally designed to encourage it? This portrait was taken with bellows and a Carl Zeiss Jena Tessar 120mm f/4.5 Compur lens that I adapted. I placed a



studio ﬂash behind the subject’s head, allowing some of the light to ﬂare directly into the lens. This dramatically reduces the amount of contrast, creating images that look washed out. By adjusting the Curves and Levels of the image in Photoshop, it is possible to set a higher level of contrast while still retaining the soft, ﬂared lighting effect. The result is a fashion-style portrait shot that is taken with a lens more than 70 years old.
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NON-INFINITY FOCUS



NON-INFINITY FOCUS WHEN mounted via an adapter, some lenses are no longer able to focus to inﬁnity. This may strike many people as being a major ﬂaw, particularly for landscape photography, but there is no reason why you have to have inﬁnity focus. Rather than trying to get everything in this image sharp
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from front to back, I have instead set the aperture to f/11 and focused on the wooden fence. This creates a depth of ﬁeld that gives plenty of detail in the foreground, but leaves the background lacking in deﬁnition, which helps to focus the viewer’s attention on the fence-staked wall and pathway.



LEARNING TO LOVE THE FLAWS
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SOFT LENS WHETHER it is caused by a soft lens, difﬁculty in focusing or by lens ﬂare, a slightly soft image can actually be beneﬁcial when shooting some subjects. For example, when taking portraits a soft lens can help mask slight imperfections in the skin. I used Photoshop CS4 to convert this image (left) to black & white, mainly using the red channel to brighten and add luminance to the skin. The soft focus and even light create a ﬂattering, natural-looking portrait.



‘Instead of trying to correct vignetting you can always leave it in the image’ VIGNETTING



HANDHOLDING



ALL IMAGES: RICHARD SIBLEY



HANDHOLDING an enlarger lens to a camera introduces a host of problems, not least the fact that it is difﬁcult to focus with any degree of accuracy. This is because the lens aperture usually has to be wide open to let in enough light to focus, which dramatically reduces the depth of ﬁeld. Also, trying to align the lens perfectly parallel to the sensor is almost impossible, so a slight tilt-andshift effect can be noticeable. Of course, all this is before stray light leaks and lens ﬂare are even considered. However, this doesn’t mean you can’t use an enlarger lens and the handholding technique. In fact, the resulting images look unique, and when combined with the right subject matter they take on an almost ethereal quality.



VIGNETTING MOST lenses suffer from vignetting to some extent, but if you are using an older lens on a digital camera with a full-frame sensor, it can become very noticeable at the edges of an image. Many digital cameras automatically apply vignetting correction, but in some cameras this may not work with manual lenses or those from another manufacturer. Of course, vignetting can easily be removed using image-editing software. However, instead of trying to correct vignetting, you can always leave it in the image. The dark edges of the images help to focus attention on the centre of the photograph, which can be particularly effective when photographing still-life images.
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SQUARE FILTERS



CHOOSING A SYSTEM THERE are many factors to consider when choosing a ﬁlter system. Although the smaller systems compatible with the Cokin A series are a good budget option, a larger format may be a better choice in the longer term. Remember you may upgrade your lenses or buy a shorter-focal-length optic in the future. The most useful ﬁlters for digital photographers are the polariser and ND grads, and these are often used for landscape photography with wideangle lenses.



SQUARE FILTERS



Filters are still essential tools, so this buyers’ guide is designed to help you choose the system to suit your photography



DIGITAL cameras offer an array of white balance and colour adjustment settings to get images looking just right in-camera. There are even dynamic-range enhancing options to bring out highlight and shadow detail. But if you don’t get it spot on at the shooting stage, there’s always image-editing software. However, while many coloured ﬁlter effects can be replicated on the computer, sometimes the best results are achieved by using a ﬁlter on the lens. Probably the most crucial ﬁlter is the graduated neutral density ﬁlter, or ND grad. This can mean the difference between a below-par landscape with a bleached-out sky and a winning image with plenty of cloud detail. What’s more, using one won’t increase noise in shadow areas, unlike most in-camera dynamic-range optimising systems. Also, there’s no need to combine images with different exposures, so it works just as well with scenes containing moving elements as it does with static subjects. Other graduated ﬁlters can be useful, too. A blue grad, for instance, can inject colour into a dull sky, while a tobacco grad can lift an autumnal woodland scene.



Polarising ﬁlters also offer something digital manipulation can’t. While it is possible to replicate their saturation-boosting effect using a computer, there’s no way to cut down reﬂections and reduce glare postcapture. Polarisers can really boost shots of water, cars or glossy leaves. There are two categories of ﬁlter: round and square. Round ﬁlters come in a range of sizes and screw on to speciﬁc optics. They are also often used for longer periods than square ﬁlters. For example, clear protective ﬁlters are screwed in place almost permanently to prevent the end element from being damaged. Black & white enthusiasts may keep a red or orange ﬁlter ﬁxed on their favourite lens to boost contrast and enhance skies. This article, however, concentrates on square ﬁlters, which require a holder and are part of a system that can be transferred between lenses by using adapter rings. The genius of this is that the ﬁlters can be moved around in their holder, so the important transition section of a graduated ﬁlter can be placed where needed. Let’s see what’s available...



Polarisers are generally the most expensive ﬁlters in a manufacturer’s range, so use this as a guide when considering future outlay. Cokin, Cromatek and Formatt supply their ﬁlters in rigid boxes, while Lee Filters uses a mixture of cardboard boxes and padded cases. These are good at keeping your ﬁlters safe, but as your collection grows it is worth investing in a purpose-made holder. Resin and polyester ﬁlters are easily scratched, so it is essential to protect them from damage.



HARD OR SOFT? FORMATT and Lee Filters (pages 104 and 106) offer graduated ﬁlters with a hard or soft transition from the coloured to the clear part. The transition of a soft graduated ﬁlter is less noticeable in the ﬁnal image. A soft ND grad, for example, can be useful for darkening the sky in a landscape where the horizon isn’t ﬂat or there are trees cutting into the bright sky. However, they can be a bit too subtle and not darken the sky sufﬁciently until they are pushed right down. Hard ND grads require careful positioning, but they work very well when there is a clear, straight horizon.



CIRCULAR OR LINEAR? MOST ﬁlter manufacturers offer two types of polarising ﬁlter: linear and circular. Although they are more effective, linear polarisers disrupt the metering and AF of cameras with beamsplitting mirrors, which is most modern DSLRs. Unless you plan to meter without the ﬁlter in place and focus manually, a circular polarising ﬁlter is the better option with a DSLR.
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ACCESSORIES COUPLING RING



This modular coupling ring joins two holders, which can then be rotated independently. It’s useful when two different graduated ﬁlters are used together, perhaps to darken the sky and inject colour into a lake.



COKIN



Intro2020, Unit 1, Priors Way, Maidenhead, Berkshire SL6 2HP. Tel: 01628 674 411. www.intro2020.co.uk COKIN is probably the most widely recognised manufacturer of square ﬁlters among enthusiast photographers. There are four sizes of ﬁlter to choose from: A series; P series; Z-Pro series; and X-Pro series. The A series has the smallest (67x67mm) ﬁlters and is recommended for lenses with ﬁlter threads between 36mm and 62mm, and focal lengths over 35mm. The P-series ﬁlters are a little larger (plain ones are 84x84mm, while grads are 84x100mm) and are a popular choice with enthusiast photographers. They are designed for optics with focal lengths as short as 20mm. The next step up, Z-Pro series, is more popular with medium-format camera users and includes more than 80 ﬁlters. The plain-coloured Z-Pro ﬁlters measure 100x100mm, while the graduated ﬁlters are 100x150mm. The extra length of the graduated ﬁlters gives more scope for positioning the transition. Finally, the Cokin X-Pro system uses 170x130mm ﬁlters and is designed for serious enthusiast and professional photographers who use medium and large-format cameras.



It is also suitable for use with extreme wideangle lenses. Cokin uses the same design for each of its ﬁlter holders and they slip easily on and off the lens adapter rings. The ﬁlters, however, have square edges and they can be awkward to slide into the holder. The thin, sharp edges aren’t the most comfortable on the ﬁngers when the ﬁlters are pressed into place. A narrow slot at the back of the holders (closest to the lens) is provided to accommodate a polarising ﬁlter. These ﬁlters are round and have a notched edge to aid rotating them within the holder. There is a reasonably extensive collection of accessories for the Cokin system, with bellows hoods for the A, P and Z-Pro series, and caps to protect the lens element while the A or P series adapter rings or holders are in place. The P series is the most popular of the Cokin range and it is more versatile than the A series. Although there is a signiﬁcant price increase when moving up to the wideangle-friendly Z-Pro series, with the exception of the polarising ﬁlters it competes well with the Lee Filters system.



FILTER RANGE There are more than 140 ﬁlters in the P series, including a polariser, coloured and ND grads, as well as plain-coloured and special-effect ﬁlters such as starbursts and diffusers.



THE COKIN RANGE Cokin offers a huge range of ﬁlters and adapter rings from 36mm (A series) to 112mm (X-Pro series), plus a good range of accessories.



Holder 58mm adapter 77mm adapter ND grad Blue grad Circular polariser Linear polariser ND Modular hood



A £14.50 £10 – £22 £22 £54.40 – £16.80 £11.70



P £15.70 £13.80 £13.80 £27.20 £27.20 £96.60 £60.70 £20.70 £19.40
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Z-Pro £69 £27.70 £27.70 £76.60 £65.50 £369 £237.20 £55.60 –



X-Pro £78.20 – £58.70 £84.90 £84.90 £392.70 £244.10 £96.70 –
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Z-PRO SERIES Built around 100x100mm ﬁlters, the Z-Pro system can be used with 35mm lenses with focal lengths as short as 20mm. Although large, the holder is still fairly lightweight.
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ACCESSORIES



GRADUATED FILTERS A slot at the front of the Matte Box accepts graduated ﬁlters. Cromatek 75 graduated ﬁlters are only 92mm long (and 84mm wide), which limits the scope for positioning the graduation.



CROMATEK



Spa Photo, Valley Road, Lillington, Leamington Spa, Warwickshire CV32 7SL. Tel: 01926 312 319. www.spaphoto.co.uk CROMATEK offers two systems: the Cromatek 75 (compatible with the Cokin P series) for use with SLRs; and the larger Cromatek 100 designed for wider-angled lenses and medium-format cameras. The Cromatek 75 Matte Box is a square plastic holder that attaches to a lens via an adapter ring. Pushing a tab at the front of the box opens the holder to reveal three ﬁlter slots to accept square Cromatek 75 ﬁlters, or the circular polariser and star-effect ﬁlters that can be rotated in the mount. There are also three thin slots for masks or gels. Graduated ﬁlters must be inserted in the slot at the front of the Matte Box. Alternatively, the Cromatek ProShade 2 combines the Matte Box with a bellows shade that is extended and closed using a rackand-pinion mechanism. This allows precise extension of the hood to avoid vignetting, but it is bulky. A lever at the bottom of the ProShade 2 helps push up the inserted grad ﬁlter to ease its removal, but it also restricts how far



the graduation can be lowered. While the plastic Cromatek 75 holders are well made, the ﬁlters are tricky to insert and care is needed to keep them level as they are pushed in. The Cromatek 100 system accommodates 100mm ﬁlters. In addition to the 100 ProShade with self-supporting bellows, Cromatek offers a clip-on Compact Filter Holder. This works well, but the clip could be a weak point in the plastic construction. Given a sufﬁcient budget, the ProShade would be the better holder because it combines a slim Matte Box that can accept two 100x125mm graduated ﬁlters and a polariser, with a bellows. Cromatek 100 ﬁlters have chamfered corners, which makes them easier to slip into their holders.



THE CROMATEK RANGE Cromatek offers a full range of ﬁlters for both systems, plus plastic and metal adapter rings from 46mm to 105mm, plus Hasselblad and Rollei bayonets.



Matte Box ProShade 2 Plastic adapters Metal adapters Compact ﬁlter holder ND grads (0.3, 0.6 or 0.9) Plain colour ﬁlters for monochrome Linear polarising ﬁlter Circular polarising ﬁlter



Cromatek 75 £9.18 £153.14 £1.99 £13.26 £27.56 £9.38



Cromatek 100 – – – £30.62-£36.76 £20.41 £34.72 –



£19.39 £24.25



– –



MATTE BOX Plain-coloured ﬁlters are inserted into slots inside the Matte Box. The drawer then clips back into place for use.
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ACCESSORIES FILTERS



Chamfered corners make the ﬁlters easier to thread into the holders, but they may need a little persuasion to get them to slip fully home.



FORMATT



Formatt Filters, Unit 23, Aberaman Park Industrial Estate, Aberaman, Aberdare, Mid Glamorgan CF44 6DA. Tel: 01685 870 979. www.formatt.co.uk



FORMATT Hitech holder systems are available in 67mm for mirrorless system cameras, 85mm for consumer DSLR lenses, and 100mm for professional DSLR cameras. In addition to these more standard sizes, there is also a 165mm holder for the Lucroit wideangle holder system. The Hitech 67, 85 and 100-series ﬁlters are compatible with the Cokin A, P and Z series respectively, so Cokin ﬁlters and ﬁlter holders can be used with the system. All three systems have aluminimum ﬁlter holders, with a two-slot holder available for the Hitech 67mm series, while the 85 and 100 series have three-slot holders. Shorter-focallength lenses may require the use of an optional wideangle adapter when used on the HiTech 100 holder. These adapters have a slightly thinner proﬁle than the standard holders and allow the ﬁlter to sit closer to the lens to help prevent the ﬁlter holder creeping into the corners of the shot. They are available in 49-82mm sizes and cost between £32.71 and £36.86. When used with the wideangle adapter ring, the Hitech 100 wideangle holder can be used on



lenses with focal lengths as short as 17mm. Unfortunately, there isn’t a wideangle adapter ring for the Hitech 85 system, which makes the Hitech 100 system a more logical choice for enthusiasts. Although Formatt offers its entire (extensive) range of polycarbonate (CR39) ﬁlters in both sizes, there are more accessories and adapters available for the Hitech 100 system, making it more versatile. Sadly, there are no hoods available for any of the systems, but polariser rings are available in the three different sizes to allow the use of a polarising ﬁlter. The rings simply screw into place on the end of the ﬁlter holders. Both system holders and adapters have a high-quality feel and are made from aluminium with plastic ﬁlter guides. Although the ﬁlters have chamfered corners, they often stick when part-way into the holder and a little wiggling may be required to encourage them to go fully home. While the linear polarisers are of extremely high build quality, with graduated markings to help ensure correct rotation, they are also the heaviest ﬁlters in this guide.



TWO-SLOT AND RING HOLDER Plain and graduated ﬁlters ﬁt into the slots, while a polarising ﬁlter can be screwed into the ring at the front. The knurled screw on the right tightens to secure the holder onto an adapter ring.



THE FORMATT RANGE Formatt offers a full range of ﬁlters for both systems, as well as metal adapter rings in sizes from 46mm to 105mm, plus a collection of bayonet adapters.



Aluminium three-slot and ring holder Metal adapters ND grads (0.3, 0.6, 0.9 or 1.2) Plain-coloured ﬁlters for monochrome Linear polarising ﬁlter Circular polarising ﬁlter ND ﬁlters



Hitech 67 Hitech 85 Hitech 100 £12 £27.74 £38.19



£8 £16.95 £11.95 £40.63 £45 £12.97
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£12.98 £23.02 £13.43 £137.21 £180.53 £18.09



£16.09-£49.32 £50.56 £39.71 – £187.76 £43.33



LINEAR POLARISER Markings on the linear polariser make it easier to keep track of how far it has been rotated.
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SQUARE FILTERS



ACCESSORIES



KOOD



Kood International Limited, Unit 6 Wellington Road, London Colney, Hertfordshire AL2 1EY. Tel: 01727 823 812. www.kood-international.com



KOOD manufactures three sizes of square ﬁlter. The most commonly available are compatible with the Cokin A and P-series holders. While the Kood holder looks almost identical to the Cokin P-series holder, markings on them make it clear that they are made in different countries. The Cokin model comes from France, while the Kood holder is from China. Slight differences in the glossiness and ﬂexibility of the two holders also suggests that they are manufactured from different plastics or by different methods. Although these differences appear only minor, they make quite a difference when sliding the holder on and off the adapter ring on a lens. The Kood holder is more rigid than the Cokin device, and this makes it more awkward to attach and detach. In fact, the French unit slips much more smoothly into place. Although Kood square ﬁlters are a little thicker than their Cokin counterparts, they slide smoothly into the holders from both manufacturers.



The Kood ﬁlters have rounded corners, which makes them easy to feed into the holders, while the ground edges ensure they are comfortable to hold. They have a higher-quality look and feel than the holders. The third system in Kood’s ﬁlter range is compatible with other 100mm-format ﬁlter holders (Kood doesn’t produce its own holder). While the plain ﬁlters are 100x100mm, the graduated versions measure 100x125mm. Their shorter length makes these ﬁlters less versatile than the grad ﬁlters from Lee and Cokin (Z-Pro and X-Pro series), but they are of high quality and reasonably priced. Kood supplies its ﬁlters in plastic envelopes lined with card to prevent colour migrating from the ﬁlter to the packaging. These envelopes are ideal for storing the ﬁlters long-term in your camera bag as they are slim and will not take up much space. However, the plastic is pliable rather than rigid, so care should be taken to avoid bending the ﬁlters.



FILTERS Kood square ﬁlters have a high-quality feel and they slip smoothly into their holders. Their rounded corners and ground edges save your ﬁngers as the ﬁlters are pushed down.



GRADUATED FILTERS Kood’s most popular range of graduated ﬁlters are compatible with the Cokin P system.



‘Although Kood square ﬁlters are a little thicker than their Cokin counterparts, they slide smoothly into the holders from both manufacturers’ THE KOOD RANGE Kood offers a fairly small collection of ﬁlters, but it includes all the digital photographer’s essentials, plus a few more besides.



Holder ND grad Blue grad Circular polariser ND



A £3.60 £13.20 £13.20 £33.60 £13.20



P £7.20 £12.17 £19.20 £48.60 £16.92



POLARISING FILTER Like the Cokin polarising ﬁlters, the Kood polarisers have a notched edge that makes it easier to rotate them in the holder



100mm – £30 £30 – £30
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SQUARE FILTERS
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ACCESSORIES



LEE FILTERS



POLYESTER FILTERS Polyester ﬁlters make a more affordable alternative to the durable resin versions and they ﬁt in the same holders.



RF75



Lee Filters, Central Way, Walworth Industrial Estate, Andover, Hampshire SP10 5AN. Tel: 01264 366 245. www.leeﬁlters.com LEE Filters is the most widely known ﬁlter manufacturer among pro photographers and its system, built around 100mm ﬁlters, is comprehensive. However, if you can’t ﬁnd the ﬁlter or holder you need, there’s a custom manufacturing service. The basic Lee Filters holder is made of strong, rigid plastic and clips quickly to a metal lens adaptor ring using a sprung brass retaining bolt. Up to four ﬁlters may be held in the mount. The professional kit includes two basic ﬁlter holders that connect via a tandem adapter. This allows the holders to be independently rotated to align two graduated ﬁlters correctly or for using a polarising ﬁlter with a grad. An upgrade kit is available to turn the basic holder into a professional kit. Screws that hold the ﬁlter guides enable an accessory ring to be attached to accommodate a round rotating polariser. Alternatively, Lee Filters offers square linear and circular polariser ﬁlters that can be used in the normal holder. Whichever polarising ﬁlter is used, it must go in front of any polyester gel ﬁlters (that is, furthest from the lens) for it to work properly. The Lee Filters’ graduated, striped



and colour-effect ﬁlters are made of resin and are sold individually or as boxed sets. While the plain resin ﬁlters measure 100x100mm, the graduated ones are 100x150mm, giving plenty of scope for positioning the transition. Lee Filters also offers a range of more affordable technical polyester ﬁlters for correcting colour casts and so on. Those needing the best possible results with long exposures should consider the Pro Glass ND ﬁlters that are optimised for use with digital cameras. These reduce the colour cast that can be caused by UV and IR light. Although most Lee Filters stills photography products are aimed at SLR, medium- and larger-format camera users, the company also has options for rangeﬁnder users. This can be as simple as adding graduated bars to the front of the basic holder to assist positioning graduated ﬁlters. Alternatively, there is the RF75 range that uses a smaller holder and a new series of 75mm wide ﬁlters. As you would expect of a product aimed at professionals, the Lee Filters system has a high-quality feel. Although they don’t have rounded corners, the resin ﬁlters slip smoothly into the holders.



This new, smaller ﬁlter system helps rangeﬁnder camera users by providing markings on the holder to aid the alignment of graduated ﬁlters.



UNIVERSAL HOOD Lee Filters offers several self-supporting bellows hoods. The Universal hood is the best choice for DSLR and mediumformat camera users. It can be used on 35mm lenses with focal lengths as short as 17mm. This hood has slots to hold up to three ﬁlters.



GELSNAP Polyester ﬁlters can be used with the GelSnap holder, which has an elastic band to attach it to a lens, so no adapter is required.



THE LEE FILTERS RANGE The Lee Filters range is huge, with an extensive collection of holders and accessories. Filters can also be made to your speciﬁcations.



Foundation kit (basic holder) £62.51 Adapter ring £21.10 Wideangle adapter ring £41.64 Lens cap (pack of 3) £3.69 105mm front holder ring £36.41 Professional kit £122.20 Gelsnap holder £39.19 Universal hood £139.36 ND resin ﬁlter £89.82 ProGlass ND ﬁlter £132.30



Resin ND grad Polyester black & white set 105mm linear polariser 100x100mm linear polariser 105mm circular polariser 100x100mm circular polariser RF75 holder RF 75 ND grad RF75 clip-on circular polariser
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£80.89 £38.32 £153.55 £144.90 £242.46 £163.80 £98.86 £58.40 £206.84
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